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チュートリアル

はじめに

本書には、9 つの Autodesk MotionBuilderチュートリアルのセットが含まれてお
り、さらに強力になったキーフレームとキャラクタアニメーション機能の使い方

を紹介します。これらのチュートリアルの一部では 2 タイプのワークフローを説
明しています。

重要: チュートリアルは、Autodesk MotionBuilderバージョン 2013、Autodesk
Maya®バージョン 2013、および Autodesk 3ds Max®バージョン 2013 を使用し
て作成および更新されています。バージョン 2013 以外のバージョンでチュートリ
アルを実行すると、結果が異なる場合があります。

注: チュートリアル「MotionBuilderに 3ds Max ファイルを読み込む」では、
Send Toのシングルステップの相互運用機能を使用します。使用しているソフト
ウェア製品がバージョン 2012 より前のものである場合は、各項目の下にある
「Note」を参照してください。MotionBuilderヘルプの適切なトピックに移動し、
チュートリアルの手続きを正しく実行できるレガシーのワークフローが表示され

ます。

チュートリアル用のアセットは、Autodesk MotionBuilderの Asset Browser の
Tutorialsフォルダ(またはシステム上の Autodesk MotionBuilderフォルダ内の
Tutorialsフォルダ)にあります。

事例: http://www.autodesk.com/motionbuilder2013-documentationにアクセスし、
チュートリアルやチュートリアルアセット(またはサポートファイル)の最新版を

ダウンロードしてください。

1

1

http://www.autodesk.com/motionbuilder2013-documentation


Asset Browserに表示するディレクトリを追加するには:

■ MotionBuilder ヘルプの『ユーザガイド』内、「MotionBuilder インタフェー
ス」の Asset Browser のトピックにある「よく使用するパスを追加する」の
トピックを参照してください。

この本には、次のチュートリアルが含まれています。

■ キャラクタモデルをロードし、キャラクタライズする (9ページ)

■ コントロールリグを作成し、カスタマイズする (21ページ)

■ キャラクタエクステンションを作成する (37ページ)

■ 歩行サイクルを作成する (49ページ)

■ キャラクタアニメーションをリターゲットする (70ページ)

■ キャラクタアニメーションを編集する (83ページ)

■ ループを作成する (97ページ)

■ クリップを操作する (115ページ)

■ MotionBuilder に 3ds Max ファイルを読み込みする (126ページ)

関連事項:

MotionBuilder のワークフロー (2ページ)

MotionBuilderのワークフロー
チュートリアルの完了に使用できるワークフローには、Autodesk 相互運用性
ワークフローと標準ワークフローの 2 つのワークフローがあります。これらの
ワークフローを使用すると、MotionBuilderソフトウェア製品について理解で
きるようになり、プロジェクトに対して最も効率的なワークフローを選択できま

す。

プロセスを合理化するために、MotionBuilderと Maya、またはMotionBuilder
と 3ds Max との相互運用性のあるプロジェクトを実行する場合には、Autodesk
相互運用性ワークフローを使用します。

Autodesk 3ds Max および Autodesk Maya の 2012 以前のバージョンを使用し
ている場合、またはMotionBuilderとともに別の 3D ソフトウェアパッケージ
を使用している場合には、標準ワークフローを使用します。詳細は、「標準ワー

クフロー (5ページ)」を参照してください。
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チュートリアルでは、キャラクタアニメーションプロジェクトのために

MotionBuilderを使用していることを前提にしていますが、このワークフロー
は、他の 3D モデリングやレンダリングソフトウェアと連動してMotionBuilder
を使用しているアニメーションプロジェクトであればどれにでも簡単に応用で

きます。

Autodesk 相互運用性ワークフロー

MotionBuilderにはシングルステップの相互運用性機能があり、File > Send
To Maya および File > Send To 3ds Max メニューオプションを使用して、
Maya または 3ds Max にモデルを送信できます。

Maya および 3ds Max のいずれにもシングルステップの相互運用性機能があり、
File > Send to MotionBuilder メニューオプションを使用して、
MotionBuilderにモデルを送信できます。

重要: シングルステップの相互運用性機能は、バージョン 2012 より前のオート
デスクのソフトウェアバージョンでは使用できません。

1 Mayaまたは 3ds Maxにキャラクタモデルを作成します。

MotionBuilderでアニメーションプロジェクトを開始する前に、モデリン
グの段階でいくつかのことに注意しておけば、その後のMotionBuilderで
のアニメーションプロジェクトの作業がスムーズになります。

これについてはMotionBuilderヘルプの「キャラクタモデルの作成のガ
イドライン」、「ボーン命名規則」、「3ds Max の Biped をMotionBuilder
に読み込みしてキャラクタライズする」、「作成するシェイプを選択する」

を参照してください。

2 File > Send to MotionBuilderを使用して、Mayaまたは 3ds Maxから
キャラクタモデルを書き出します。

MotionBuilder2013がインストールされている場合には、キャラクタモ
デルを起動してロードします。

3 モデルがMotionBuilderにロードされたら、3ds MaxまたはMotionBuilder
のキャラクタアセットをその上にドラッグしてアニメーション化する準備

をします。

キャラクタアセットを使用すると、キャラクタモデルの構造をマップ化

して、MotionBuilderでアニメーション化するのに役立ちます。このマッ
ピングプロセスを完了したら、キャラクタモデルをキャラクタライズし

て、アクティブ化します。キャラクタライズにより、このキャラクタモデ

ルをアニメーション化する準備が整ったことがMotionBuilderに伝えられ
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ます。1 つ目のチュートリアルでは、キャラクタモデルを MotionBuilder
に読み込みし、アニメーション化する準備を行う方法について説明します。

詳細は、「キャラクタモデルをキャラクタライズする (18ページ)」を参
照してください。

4 コントロールリグを追加し、キャラクタアニメーションでの必要に応じ

て、カスタマイズします。

コントロールリグはキャラクタモデルの制御や配置をしやすくするため

のアニメーションツールです。

2 つ目のチュートリアルでは、コントロールリグのカスタマイズ方法、お
よび床の接触や Auxiliary ピボットなどのキャラクタアニメーション機能
の追加方法について説明します。

コントロールリグを作成し、カスタマイズする (21ページ)を参照してく
ださい。

5 プロップ(小道具)や人間以外の身体部分をサポートするために、キャラク

タエクステンションを追加します。

3 つ目のチュートリアルでは、余分な手足を持つキャラクタを追加する方
法について説明します。この例では、キャラクタの右肩に、大きなハサミ

の付いた「サーボアーム」を追加します。

キャラクタエクステンションを作成する(37ページ)を参照してください。

6 キーフレーム操作やキャラクタアニメーション機能を使用して、アニメー

ションを作成します。

■ アニメーションを作成するための効率的な手法の 1 つとして、いろい
ろな時点で、キャラクタにペーストできるポーズのセットを作成するこ

とができます。

4 つ目のチュートリアルでは、コントロールリグと Pose Control を使
用して、歩行サイクルを作成する方法を説明します。

歩行サイクルを作成する (49ページ)を参照してください。

■ 7 つ目のチュートリアルでは、Story ウィンドウでクリップを使用し
て、歩行サイクルを作成する方法について説明します。

ループを作成する (97ページ)を参照してください。

7 アニメーションを編集し、微調整します。

■ 6 つ目のチュートリアルでは、レイヤを使用して、アニメーションを編
集する方法について説明します。

キャラクタアニメーションを編集する (83ページ)を参照してくださ
い。
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■ 8 つ目のチュートリアルでは、Story ウィンドウを使用してアニメー
ションを結合する方法について説明します。

クリップを操作する (115ページ)を参照してください。

8 Characterモデル同士の間で、アニメーションをリターゲットします。

アニメーションプロジェクトの途中で、キャラクタモデルが変更される

こともあり得ます。MotionBuilderでのアニメーション作成に必須の手順
ではありませんが、新しいモデルでアニメーションを作成し直すのではな

く、単純に同じアニメーションを別のモデルに適用することも可能です。

5 つ目のチュートリアルでは、キャラクタモデルどうしの間で、アニメー
ションとキャラクタエクステンションを転送する方法について説明しま

す。

キャラクタアニメーションをリターゲットする (70ページ)を参照してく
ださい。

9 MotionBuilderで 3ds Maxキャラクタをアニメートした後、そのアニメー
ションを 3ds Maxで使用するには、3ds Maxシーンを MotionBuilderに
読み込みし、MotionBuilderでアニメートした後、3ds Maxにアニメー
ションを読み込みする必要があります。

最後のチュートリアルでは、MotionBuilderにアニメーションを読み込み
し、MotionBuilderでアニメートし、MotionBuilderからアニメーション
を書き出し、それを 3ds Max に読み込みする主な手順について説明しま
す。

「3ds Max のスケルトン (128ページ)」、「3ds Max の Biped (141ペー
ジ)」、「3ds Max のキャラクタ (154ページ)」、「3ds Max のキャラクタ
を MotionBuilder でアニメートする (162ページ)」のトピックを参照して
ください。

標準ワークフロー

Maya および 3ds Max 2012 のいずれにも、MotionBuilderにモデルを自動的に
取り込むワンステップの相互運用性機能があります。これらのパッケージの 2012
バージョンがない場合には、適切な Maya または 3ds Max FBX プラグインをイ
ンストールして、モデルをMotionBuilderに転送する必要があります。無償の
FBX プラグインは http://www.autodesk.co.jp/fbxからダウンロードできます。
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別の 3D ソフトウェアパッケージを使用している場合には、
www.Autodesk.co.jp/fbxからダウンロードできる無償の FBX Converter を使用
してファイルを FBX に変換することができます。

1 3Dソフトウェアでキャラクタモデルを作成します。

MotionBuilderでアニメーションプロジェクトを開始する前に、モデリン
グの段階でいくつかのことに注意しておけば、その後のMotionBuilderで
のアニメーションプロジェクトの作業がスムーズになります。

これについてはMotionBuilderヘルプの「キャラクタモデルの作成のガ
イドライン」、「ボーン命名規則」、「3ds Max の Biped をMotionBuilder
に読み込みしてキャラクタライズする」、「作成するシェイプを選択する」

を参照してください。

2 モデリングソフトウェアパッケージからキャラクタモデルを書き出しま

す。

モデリングソフトウェアパッケージから作品を書き出する場合、インス

トールした FBX Plug-in により、キャラクタモデルを .fbxファイルフォー
マットで保存することができます。このフォーマットを使用すれば、

MotionBuilderにモデルをロードできます。

3 MotionBuilderを起動し、キャラクタモデルをロードします。

モデルをMotionBuilderにロードしたら、MotionBuilderキャラクタア
セットを使用して、このモデルがアニメートされるようにセットアップで

きます。

4 モデルがMotionBuilderにロードされたら、3ds MaxまたはMotionBuilder
のキャラクタアセットをその上にドラッグしてアニメーション化する準備

をします。

キャラクタアセットを使用すると、キャラクタモデルの構造をマップ化

して、MotionBuilderでアニメーション化するのに役立ちます。このマッ
ピングプロセスを完了したら、キャラクタモデルをキャラクタライズし

て、アクティブ化します。キャラクタライズにより、このキャラクタモデ

ルをアニメーション化する準備が整ったことがMotionBuilderに伝えられ
ます。

5 キャラクタモデルにキャラクタアセットを追加し、キャラクタライズしま

す。

キャラクタアセットを使用すると、キャラクタモデルの構造をマップ化

して、MotionBuilderでアニメーション化するのに役立ちます。このマッ
ピングプロセスを完了したら、キャラクタモデルをキャラクタライズし

て、アクティブ化します。キャラクタライズにより、このキャラクタモデ
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ルをアニメーション化する準備が整ったことがMotionBuilderに伝えられ
ます。コントロールリグや Story ウィンドウでのアニメートを含め、
MotionBuilderの主要なキャラクタアニメーション機能すべてで、キャラ
クタライズされたキャラクタが必要です。

最初のチュートリアルでは、Character アセットの作り方と、これを使用
して、キャラクタモデルの構造をマップ化する方法について説明します。

キャラクタモデルをロードし、キャラクタライズする (9ページ)を参照
してください。

6 コントロールリグを追加し、キャラクタアニメーションでの必要に応じ

て、カスタマイズします。

コントロールリグはキャラクタモデルの制御や配置をしやすくするため

のアニメーションツールです。

2 つ目のチュートリアルでは、コントロールリグのカスタマイズ方法、お
よび床の接触や Auxiliary ピボットなどのキャラクタアニメーション機能
の追加方法について説明します。

コントロールリグを作成し、カスタマイズする (21ページ)を参照してく
ださい。

7 プロップ(小道具)や人間以外の身体部分をサポートするために、キャラク

タエクステンションを追加します。

3 つ目のチュートリアルでは、余分な手足を持つキャラクタを追加する方
法について説明します。この例では、キャラクタの右肩に、大きなハサミ

の付いた「サーボアーム」を追加します。

キャラクタエクステンションを作成する(37ページ)を参照してください。

8 いろいろなキーフレーム設定やキャラクタアニメーション機能を使用し

て、アニメーションを作成します。

■ アニメーションを作成するための効率的な手法の 1 つとして、いろい
ろな時点で、キャラクタにペーストできるポーズのセットを作成するこ

とができます。

4 つ目のチュートリアルでは、コントロールリグと Pose Control を使
用して、歩行サイクルを作成する方法を説明します。

歩行サイクルを作成する (49ページ)を参照してください。

■ 7 つ目のチュートリアルでは、Story ウィンドウでクリップを使用し
て、歩行サイクルを作成する方法について説明します。

ループを作成する (97ページ)を参照してください。
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9 アニメーションを編集し、微調整します。

■ 6 つ目のチュートリアルでは、レイヤを使用して、アニメーションを編
集する方法について説明します。

キャラクタアニメーションを編集する (83ページ)を参照してくださ
い。

■ 8 つ目のチュートリアルでは、Story ウィンドウを使用してアニメー
ションを結合する方法について説明します。

クリップを操作する (115ページ)を参照してください。

10 Characterモデル同士の間で、アニメーションをリターゲットします。

アニメーションプロジェクトの途中で、キャラクタモデルが変更される

こともあり得ます。MotionBuilderでのアニメーション作成に必須の手順
ではありませんが、新しいモデルでアニメーションを作成し直すのではな

く、単純に同じアニメーションを別のモデルに適用することも可能です。

5 つ目のチュートリアルでは、キャラクタモデルどうしの間で、アニメー
ションとキャラクタエクステンションを転送する方法について説明しま

す。

キャラクタアニメーションをリターゲットする (70ページ)を参照してく
ださい。

11 完成したアニメーションをモデルのスケルトンにプロットします。

キャラクタアニメーションの作成に使用しているアニメーション機能に

よっては、コントロールリグからキャラクタモデルスケルトンへのプロッ

ト作業や、Story ウィンドウのトラックをシングルテイクにプロットする
作業が行われます。

アニメーション化に使用される方法が何であれ、書き出す前に、完成した

結果をキャラクタモデルのスケルトンにプロットする必要があります。

MotionBuilderヘルプの「アニメーションをプロットする」にある「プ
ロットプロセス」を参照してください。

12 プロットしたモデルを .fbxファイルとして保存します。
完成したアニメーションは、任意のソフトウェアでレンダリングできるよ

うに、適切な FBX Plug-In を使用して書き出することもできます。

最新の FBX Plug-in は、http://www.autodesk.co.jp/fbxからダウンロードで
きます。

関連事項:

最新の FBX Plug-in をインストールする (9ページ)
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最新の FBX Plug-in をインストールする
Autodesk® FBX®テクノロジは、最も幅広く使用され、サポートされているプ

ラットフォームに依存しない 3D データ交換ソリューションの 1 つです。
Autodesk FBX で広範囲に 3D アセットを交換することで、データ互換性の障害
が取り除かれ、プロジェクトの効率を向上させるパイプラインをより自由に構築

することができます。

Autodesk FBX は、複数のオートデスク製品間での相互運用性を促進します。
MotionBuilderソフトウェア製品が FBX をネイティブでサポートしていること
に加え、Autodesk Maya と Autodesk 3ds Max ソフトウェア製品には FBX プラ
グインが付属しています。さらに Autodesk® Softimage®ソフトウェア製品で
は、Autodesk® Crosswalk ソフトウェアを介して FBX ファイルの読み込みと書
き出しが可能です。Autodesk® Mudbox ™ 2010 ソフトウェアは、Mudbox で
は初めて FBX をサポートしたリリースで、Mudbox、Maya、3ds Max、
MotionBuilder間の共通ワークフローが一層強化されています。

最新の FBX プラグインとそのドキュメントは、http://www.autodesk.co.jp/fbxか
らダウンロードできます。

キャラクタモデルをロードし、キャラクタライ
ズする

このチュートリアルでは、キャラクタモデルをMotionBuilderに取り込み、ア
ニメーションにするための準備の手順について説明します。

コントロールリグを作成し、ポーズを作成し、その他のアニメーションツール

を使用するには、MotionBuilderに取り込んだキャラクタモデルをキャラクタ
ライズする必要があります。キャラクタモデルをキャラクタライズするには、

モデルの構造をマッピングする必要があります。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (10ページ)

■ キャラクタマップを仕上げる (13ページ)

■ キャラクタモデルをキャラクタライズする (18ページ)
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このチュートリアルで使用するアセット:

■ mia_blue.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

シーンを準備するには:

1 メニューバーから File > New を選択し、次に Layout > Editing を選択し
ます。

MotionBuilderは、Editing レイアウトを使用して新しい 3D シーンを表
示します。このレイアウトには、このチュートリアルで作業するのに必要

なすべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_blueアセット(mia_blue.fbxファイル)を Asset Browser から Viewer
ウィンドウへドラッグし、FBX Open > <No Animation> を選択します(図
を参照)。
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Viewer ウィンドウに、Mia という名前のモデルが T-スタンスで表示され
ます。
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T-スタンスの Mia

注: このモデルは Maya で作成されたもので、ボーンにはMotionBuilder
のマッピングリストにある命名規則に従って名前が付けられています。

4 File > Save As を選択します。

Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。
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キャラクタマップを仕上げる

次の手順では、マッピングリスト内で必要なノードをマッピングして、

MotionBuilderのキャラクタモデルの構造を定義します。キャラクタマッピン
グは、MotionBuilderに対してキャラクタモデルを記述する作業で、何が足で
何が腕にあたるかといったことを指示していきます。

Character アセットを直接、キャラクタモデルにドラッグしてキャラクタのマッ
ピングとキャラクタライズを自動で処理することもできますが、このチュートリ

アルでは Mia の構造を手動でマッピングします。

キャラクタマップを仕上げるには:

1 Asset Browser の Templates > Charactersフォルダから、シーンの空の領
域に Characterアセットをドラッグします。

キャラクタアセットをシーンにドラッグします。

Character アセットが Scene Browser に追加され(A)、Navigator ウィンド
ウに Character Settings が表示されます(B)。
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Navigatorウィンドウ: A. Scene Browserのキャラクタ B. Character Settings

2 Character Settings で Character Definition ペインに切り替えて、マッピ
ングリストでノードの Base (required)グループを展開します(A)。

Character Definitionペイン: A. Baseノード

このノードグループは、MotionBuilderがキャラクタモデルの構造を認
識するための必須のグループです。キャラクタを自動的にキャラクタライ

ズしたとすると、マッピングリストにはキャラクタのボーン名が自動的に

入力されます。

3 Viewer ウィンドウで、Schematic ビューに切り替え([Ctrl]+[W] キー)、[A]
キーを押して、階層をフレームします。
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Mia構造の Schematicビュー

Schematic ビューを使用すると、各ボーンが長方形のノードとして表され
るので、モデルの階層からボーンを選択しやすくなります。

4 Scene Browser で Lock オプションを有効にして、Character Definition
ペインのビューをロックします。

Navigatorウィンドウ: A. Scene Browser Lockオプションがオン

5 Schematic ビューで、ズームインとパンを行って Mia:LeftUpLegノード
を検索し、このノードを選択します。

[ビューアナビゲーション]ボタン: A. [移動ボタン B. [ズーム]ボタン
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ヒント: Viewer ウィンドウでは、 [Ctrl]キーを押しながらドラッグして
ズームインしたり、[Shift]キーを押しながら移動(またはパン)することが
できます。

Mia:LeftUpLegノードが選択された状態

注: Schematic ビューで選択したいノードの正確な名前が分かっている場
合は、Shift+Nキーを押して Find Model by Name ダイアログボックス
を開き、ノードをすばやく検索できます。

6 Mia:LeftUpLegノードを Base (required)LeftUpLegのマッピングリスト
スロットへ、[Alt]キーを押しながらドラッグします。

MotionBuilderの LeftUpLegにマッピングされた Miaの LeftUpLegノード
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このキャラクタをキャラクタライズすると、MotionBuilderは、このスケ
ルトンについては LeftUpLegノードを「Mia:LeftUpLeg」と呼ぶことを認
識します。

7 次のチェックリストと図をガイドとして使用し、残りの Mia ボーンを、
マッピングリストの Base (必須)ノードにマップします。

注:  Mia には多くのボーンがありますが、MotionBuilder のキャラクタラ
イズでは、15 個の Base グループをマッピングする必要があるだけです。

マップ済みスロットボーン

HipsMia:Hips

XLeftUpLegMia:LeftUpLeg

LeftLegMia:LeftLeg

LeftFootMia:LeftFoot

RightUpLegMia:RightUpLeg

RightLegMia:RightLeg

RightFootMia:RightFoot

SpineMia:Spine

LeftArmMia:LeftArm

LeftForeArmMia:LeftForeArm

LeftHandMia:LeftHand

RightArmMia:RightArm

RightForeArmMia:RightForeArm
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マップ済みスロットボーン

RightHandMia:RightHand

HeadMia:Head

Base グループのキャラクタマッピングが完了すると、マッピングリスト
は次の図のようになります。

Miaの Baseボーンをマッピングリストの Baseノードにマッピングした状態

これでキャラクタマッピングは完了です。

キャラクタモデルをキャラクタライズする

次の手順では、モデルをキャラクタライズする方法について説明します。キャラ

クタモデルをキャラクタライズすると、マッピングリストで定義した構造が

MotionBuilderにより読み取られ、モデルの現在のポーズが以降のすべてのポー
ズと動きのベースになると解釈されます。
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キャラクタモデルをキャラクタライズするには:

1 Character Definition ペインで、Characterize オプションを有効にします
(A)。

Character Definitionペイン A. Characterizeオプション

2 表示される Character ダイアログボックスで Biped をクリックします。
これは、Mia スケルトンが 2 本脚で立ち、足だけで床と接触するためで
す。

Characterダイアログボックスの Bipedオプション

キャラクタがすべてのソースと互換性を持ち、キャラクタがキャラクタラ

イズされ、MotionBuilder がその構造を認識するように汎用のオフセット
が計算されます。

マッピングリストのノードはグレーになり、編集できません。
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注: 後でボーンを追加したり、マッピングリストを編集したりする必要が
ある場合は、キャラクタが T-スタンスであるときに、Characterize オプ
ションを一時的に無効にします。

3 Scene Browser で、Characterブランチを展開し、キャラクタアセットを
右クリッし、コンテキストメニューから Rename を選択して、キャラク
タに Mia という名前を付けます(A)。

Scene Browser A. Characterアセットに Miaという名前を付けます。
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キャラクタは完全にキャラクタライズされ、アニメートする準備が整いま

した。

まとめ

このチュートリアルでは、キャラクタモデルをロードし、その構造をマップ化

して、キャラクタライズしました。

次のチュートリアル、コントロールリグを作成し、カスタマイズする (21ペー
ジ)では、キャラクタライズしたキャラクタのためにコントロールリグを作成し、

カスタマイズします。

コントロールリグを作成し、カスタマイズする

このチュートリアルでは、コントロールリグを作成し、後のチュートリアルで

アニメーションを作成するために、このコントロールリグをカスタマイズする

方法について説明します。

コントロールリグはキャラクタモデルの制御や配置をしやすくするためのアニ

メーションツールです。コントロールリグは他のモデルに再利用することがで

きます。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (22ページ)

■ コントロールリグを作成する (23ページ)

■ 足のフロアコンタクトマーカを調整する (28ページ)

■ 手とフロアコンタクトマーカを調整する (31ページ)

■ Auxiliary ピボットを追加する (32ページ)

このチュートリアルで使用するアセット:

■ mia_characterized.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。
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事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

シーンを準備するには:

1 メニューバーから File > New を選択し、次に Layout > Editing を選択し
ます。

MotionBuilderは、Editing レイアウトを使用して新しい 3D シーンを表
示します。このレイアウトには、このチュートリアルで作業するのに必要

なすべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_characterizedアセット(mia_characterized.fbxファイル)を Asset
Browser から Viewer ウィンドウへドラッグし(図を参照)、FBX Open >
<No Animation> を選択します。

Viewer ウィンドウに Mia という名前のモデルが T-スタンスで表示されま
す。
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T-スタンスの Mia

4 File > Save As を選択します。

Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

コントロールリグを作成する

次の手順では、Mia キャラクタのコントロールリグを作成および準備します。

コントロールリグを作成するには:

1 Scene Browser で Charactersのブランチを展開表示し、Miaキャラクタ
をダブルクリックして Character Definition ペインにアクセスします。

2 Navigator ウィンドウの Character Definition ペインをクリックし、
Control Rig 領域の Create をクリックします。
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Create Control Rig ダイアログボックスが表示されます。

3 FK/IK をクリックします。

Mia キャラクタに対する FK/IK コントロールリグが作成され、Character
Controls ウィンドウの Controls タブに Mia キャラクタの(モーション)ソー
スとして表示されます 
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4 Viewer ウィンドウをクリックし、X-Ray 表示モードになるまで[Ctrl] +
[A]キーを押し続けます。
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注: 表示モードは Viewer ウィンドウの左下に表示されます。

コントロールリグを作成し、カスタマイズする | 27



X-Ray 表示モードでは、コントロールリグを構成する FK エフェクタと IK
エフェクタを確認できます。

■ 青色と赤色の IK エフェクタでは、人間の体の動きをシミュレートする
設定を使用して、直感的にキャラクタを操作できます。

■ 黄色の FK エフェクタでは、個々のボディパーツを選択して微調整で
きます。キャラクタの微調整を行う予定の場合は、FK エフェクタと IK
エフェクタの両方を使用してコントロールリグを作成します。

5 Navigator ウィンドウで Character Settings ペインの表示に切り替えます。

Character Settingsペイン A. Input Typeメニュー B. Activeオプションがオンの
状態

コントロールリグは、Character Settings ペインの Input Type メニュー
および Active オプションでも、アクティブなモーションソースとして表
示されます(A および B)。

足のフロアコンタクトマーカを調整する

次の手順では、フロアコンタクトマーカーを使用して、キャラクタの足がどの

ようにフロア(床面)に接触するかを調整します。

フロアコンタクトマーカーは、キャラクタモデルをキャラクタライズすると

キャラクタの手と足の周囲に表示される青色と緑色のマーカーです。これらの

マーカーは、キャラクタの足がフロアと接触する場所を決める不可視のグリッド

を作成します。
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緑と青のフロアコンタクトマーカが、Miaの両手と両足の周囲に表示されます。

注: Character Definition ペインのマッピングリストでフロアオブジェクトが
定義されていない場合、MotionBuilderのグリッドが床として使用されます。
このチュートリアルでは、フロアは定義しません。

足のフロアコンタクトマーカーを調整するには:

1 Viewer ウィンドウで View メニューをクリックし、Orthographic >
Producer Right を選択して(または Viewer 内でクリックし、Ctrl+Rキー
を押して)、Producer Right カメラビューに切り替えます。

2 Mia の足にズームインします(図を参照)。

3 Mia の足の下にあるフロアコンタクトマーカーのいずれかをクリックし
ます。

4 Viewer ツールバーで Translate ボタンをクリック(Tキー)して Translate
モードをアクティブにします。

5 フロアコンタクトマーカーを移動します。次の説明と図を参考にして、

マーカーの位置を合わせてください。

■ 中部のマーカーをつま先のボーンが始まる場所に位置合わせします(B)。

■ 前部のマーカーをモデルのつま先に位置合わせします(A)。

■ 後部のマーカをモデルのかかとに位置合わせします(C)。
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Miaの足とフロアコンタクトマーカ A.前部のマーカ B.中部のマーカ C.後部
のマーカ

注: 片方の足のマーカを移動すると、それに合わせてもう片足のマーカ
も調整されます(つまり、Mia の左足の緑のマーカを調整すると、右足
の青のマーカも自動的に調整されます)。

6 Orthographic Producer Front ビューに切り替えて([Ctrl]+[F] )、両足に
ズームインして([Ctrl]+ドラッグ)、足のマーカを左右に移動させて次の図
のように両足の端に配置します。

マーカーの左および右の位置

7 Character Settings ペインで Floor Contacts (A)を展開し、 Feet Floor
Contactオプション(B)をオンにします。
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Character Settingsペイン A.プロパティの Floor Contactsグループ B. Feet Floor
Contactオプション

手とフロアコンタクトマーカを調整する

ここでは、Mia の手がフロア(床)に触れたときにリアルに反応するように、手の
フロアコンタクトを定義します。

手とフロアコンタクトマーカーを調整するには:

1 Scene Browser でMiaキャラクタをダブルクリックし、Character Settings
ペインをクリックして Character Settings を表示します。

2 Character Settings ペインで、 Floor Contacts (A)が展開されていない場
合はこれを展開し、 Hands Floor Contact (B)オプションと Fingers Floor
Contact (C)オプションをオンにして、手と指のフロアコンタクトを有効
にします。

Character Settingsペイン A. Floor Contacts B. Hands Floor Contact C. Fingers
Floor Contact
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3 Hands Floor Contact Setupを展開し、Hands Contact Typeメニュー(A)
をクリックして Wristを選択します。

Character Settingsペイン: A. Hands Contact Type B. Wrist Hands Contact Type

既定では Hands Contact Typeは Normalに設定されており、手には 6 個
のフロアコンタクトマーカが割り当てられます。このオプションをWrist
に変更すると、それぞれの手に基本的な制御のための 4 個のフロアコンタ
クトマーカーが提供されます。

4 Viewer ウィンドウで各種カメラビューを使用して、Mia の左右どちらか
の手にズームインします。

5 手の後部のマーカを手首に、前部のマーカを指(親指以外)の付け根に位置

合わせします。さらに、次の図に示すように、後部のマーカを Y 軸に沿っ
て下へ移動して、手のひらの付け根に位置合わせします。

Auxiliary ピボットを追加する

次の手順では、Mia のコントロールリグにある IK システムをさらに詳細に制御
できるようにする 2 つの Auxiliary ピボットを作成します。これらの Auxiliary
オブジェクトを使用して、Mia の歩行に伴い、Mia の足にリアルな回転を作成
できます。また、これらのオブジェクトを使用すると、キーフレームアニメー

ションの作成時に Mia の足を回転しやすくなります。
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補助ピボットを追加するには:

1 Character Controls ウィンドウで、Left Ankle セルを右クリックし、コン
テキストメニューから Create Aux Pivot を選択します。
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左足首の IK エフェクタに Auxiliary ピボットが作成されます(A)。Auxiliary
ピボットは、Character Controls ウィンドウの Left Ankle セルでは X 印
で示されます(B)。

A. Viewerウィンドウの Auxiliaryピボット B. X印が Auxiliaryピボット

既定では、Auxiliary ピボットを作成すると、足のエフェクタは選択解除さ
れ、Auxiliary ピボットが選択されます。Viewer ウィンドウで、Pivot
Selection モードが自動的に選択されます。

Viewerウィンドウ A. Pivot Selectionモード

2 次の図のように作成した Auxiliary ピボットが選択されていない場合はこ
れを選択し、移動して Mia のつま先と重なる位置に配置します。
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左足首の Auxiliaryピボット A.前面図 B.側面図

注: Character Controls ウィンドウの  > Show/Hide メニューを使
用して、補助ピボットを配置するときにフロアコンタクトマーカーを非表

示にすることができます。

3 Left Ankle セルをもう一度右クリックし、コンテキストメニューから
Create Aux Pivotを選択します。
Viewer ウィンドウに 2 つ目の Auxiliary ピボットが表示されます。

4 2 つ目の Auxiliary ピボットをかかとの位置に移動します(図を参照)。

まとめ

このチュートリアルでは、コントロールリグを作成し、キャラクタの足にフロ

アコンタクトマーカを配置してから、足の回転を制御するために 2 つの Auxiliary
ピボットを作成しました。

次のチュートリアル、キャラクタエクステンションを作成する (37ページ)で
は、Mia キャラクタに Character Extension を追加します。
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キャラクタエクステンションを作成する

このチュートリアルでは、キャラクタに追加された付属物を制御できるようにす

るためのキャラクタエクステンションの作成に必要な手順について説明します。

ここでは、Mia キャラクタの腕をロードし、キャラクタエクステンションを使
用して腕を Mia にアタッチしたら、胴体に対応して動く腕のアニメーションを
定義します。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (37ページ)

■ 追加した腕をキャラクタに接続する (39ページ)

■ キャラクタエクステンションを作成する (44ページ)

このチュートリアルで使用するアセット:

■ mia_rigged.fbx
■ servo.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。
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シーンを準備するには:

1 メニューバーから File > New を選択し、次に Layout > Editing を選択し
ます。

MotionBuilderは、Editing レイアウトを使用して新しい 3D シーンを表
示します。このレイアウトには、このチュートリアルで作業するのに必要

なすべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_riggedアセット(mia_rigged.fbxファイル)を Asset Browser から
Viewer ウィンドウへドラッグし、コンテキストメニューから FBX Open
> <No Animation> を選択します(図を参照)。

キャラクタライズされた Miaが Viewerウィンドウに表示されます。

Viewer ウィンドウに Mia というキャラクタライズ済みのモデルが T-スタ
ンスで表示されます。

4 Asset Browser の servoアセット(servo.fbxファイル)をシーンへドラッグ
し、コンテキストメニューから FBX Merge > <No animation> を選択し
ます。

サーボアームがシーンにロードされ、Mia の肩の上に配置されます。次の
手順では、もう 1 本の腕として、この腕を Mia にアタッチします。
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Miaとサーボアームがシーンにロードされた状態

5 File > Save As を選択します。

Save File ウィンドウが表示されます。

6 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

7 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

追加した腕をキャラクタに接続する

次の手順では、サーボアームと Mia の肩の間に親子関係を作成します。

追加した手足をキャラクタに接続するには:

1 Viewer ウィンドウを X-Ray 表示モードに切り替えます（Ctrl+Aキー）。

注: キーボードショートカット[Ctrl]+[A]キーを押すと Normal モード、
Models Only モード、X-Ray モードが順に切り替わります。
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2 Character Controls ウィンドウで、Mia が現在のキャラクタとして選択さ
れていることを確認します。

3 Viewer ウィンドウをクリックして、次の操作を実行します。

■ Ctrl+Wキーを押して Schematic ビューに切り替えます。

■ Schematic ビュー内を右クリックし、コンテキストメニューから
Auto-Arrange を選択してから Arrange-All を選択します。

■ Aキーを押して、Schematic ビューにすべてのノードを表示します。

Schematic ビューには、Mia のスケルトンの階層(A)、コントロールリ
グ(B)、およびサーボアームの 3 番目の階層が表示されます
(「ServoMaster」、C)。

シーンの階層構造の Schematicビュー A. Miaのスケルトン B. Miaのコント
ロールリグ C.サーボアーム

4 ビューの右側で、サーボアーム(ServoMaster)階層にズームインし(C)、
ServoMaster ノードを選択します。
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ServoMasterノードを選択

5 Producer カメラビューに切り替え(Ctrl+Wキー)、Mia の右肩にズームイ
ンします。ServoMaster ノードのヌルが依然として選択されています。

Viewerウィンドウで ServoMasterのヌルが選択されています。

6 [P]キーを押して Parent モードを有効にした後、ServoMaster のヌルを
Mia:RightShoulder ボーンにドラッグします(A)。

サーボアームに親子の関連付けを行うと、ボーンは緑色で強調表示されま

す。これにより、サーボアームは右肩ボーンの子になります(B)。
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A. ServoMasterのヌルを Miaの右肩ボーンの子に設定 B.親子関係が設定された状
態

7 Schematic ビューに切り替えて、サーボアームが Mia:RightShoulder ボー
ンの子になっていることを確認します。

Schematicビューで見た親子関係 A. Mia:RightShoulderボーン B.サーボアーム
階層

注: Mia:RightShoulder ノードは Schematic ビューの左側に表示されま
す。必要に応じて、右クリックして Auto Arrange を選択し、表示を整理
します。

8 Producer Perspective ビューに切り替えます。

9 Mia のサーボアームの先端にある ServoControl エフェクタ(A)を選択し、
Parent モードで同様に Mia の右肩ボーンの子に設定します。
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A. ServoControlエフェクタ B.右肩ボーン

10 Schematic ビューに切り替えて、ServoControl エフェクタが
Mia:RightShoulder ボーンの子になっていることを確認します。

Schematicビューで見た親子関係 A. Mia:RightShoulderボーン B. ServoControl
エフェクタ
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キャラクタエクステンションを作成する

ここでは、キャラクタエクステンションを作成してサーボアームを Mia キャラ
クタに接続することで、サーボアームと Mia キャラクタをまとめてコントロー
ルし、キーフレームを設定できるようにします。

キャラクタエクステンションを作成するには:

1 Scene Browser で、Characters を展開し、Mia を右クリックして、コンテ
キストメニューから Create Character Extension を選択します(A)。

Scene Browser A. Create Character Extensionオプション

2 Scene Browser で Character Extensions フォルダを展開し、Mia Extension
を表示します(C)。
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Scene Browser A. Miaキャラクタに追加されたキャラクタエクステンション B.
Scene Browserに追加された Character Extensions項目 C. Miaキャラクタにち
なんで名づけられたキャラクタエクステンション

3 Producer Perspective ビューに切り替えます。

4 Scene Browser で、Viewer ウィンドウの ServoControl エフェクタを Alt

キーを押しながらMia Extension上にドラッグし、コンテキストメニュー
から Add to Mia Extensionを選択します(次の図を参照)。
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A. ServoControlエフェクタ B. ServoControlエフェクタを Mia Extensionに追加
します。

サーボアームは Mia のキャラクタエクステンションとして定義され、キャ
ラクタの新しい「ボディパーツ」として認識されます。

5 ServoControl エフェクタを選択したままの状態で、Properties ウィンドウ
を開きます。

注: Properties ウィンドウは、インタフェースの右側にある Resources ペ
インのタブの 1 つです。または、メニューバーからWindow > Add
Property View をクリックして、ウィンドウを表示します。

Propertiesウィンドウ
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6 緑色のカスタムプロパティ Close_Openを選択し、スライダを左右にド
ラッグします(図を参照)。

A.サーボアームが開きます。B.カスタムプロパティ Close_Open

Viewer ウィンドウでは、サーボアームのハサミが動きます。

7 Altキーを押しながら、 Close_Openプロパティを Mia Extension上に
ドラッグし(A)、コンテキストメニューから Create 1 Property Reference
を選択します(B)。

A. Close_Openプロパティを Mia Extension上へドラッグします。B. Create 1
Property Referenceを選択します。

8 Scene Browser で Mia Extensionを選択し(A)、Properties ウィンドウの
Lock オプションを有効にして(B)、何を選択しても Mia Extensionのプロ
パティが開いたままになるようにします。
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A. Mia Extensionを選択します。B. Propertiesウィンドウの Lockオプションをオ
ンにします。

9 Altキーを押しながら、Mia:RightShoulder ボーンを Properties ウィンド
ウの Reference Object フィールドにドラッグして(A)、Mia の右肩ボーン
をキャラクタエクステンションのリファレンスオブジェクトとして定義し

ます(B)。

A. Mia:RightShoulder B. Mia:RightShoulderリファレンスオブジェクト

10 表示される Reference Object Change ダイアログボックスで OK をクリッ
クします。

キャラクタエクステンションのリファレンスオブジェクトは、たとえば

ポーズにキャラクタエクステンションが含まれている場合に、エクステン

ションの以降のすべての位置を計算するのに使用されます。

48 | 第 1 章 チュートリアル



注: Properties ウィンドウで Add To Full Bodyオプションを有効にし
て、Full Body キーイングモードでキーを設定するときに、キャラクタエ
クステンションをキー操作するかどうかを定義します。

「MotionBuilder Help」 > 「キャラクタをアニメートする」 > 「キャラ
クタセットアップ」 > 「キャラクタエクステンション」 > 「Character
Extension プロパティ」を参照してください。

まとめ

このチュートリアルでは、キャラクタエクステンションを作成して、Mia キャ
ラクタに腕を追加しました。

次のチュートリアル(歩行サイクルを作成する(49ページ))では、Pose コントロー
ルを使用して、このキャラクタとキャラクタエクステンションをアニメートし

ます。

歩行サイクルを作成する

このチュートリアルでは、ポーズを使用して、歩行サイクルを作成する手順につ

いて説明します。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (50ページ)

■ ポーズを作成する (53ページ)

■ ポーズを使ってアニメーションを作成する (62ページ)

■ ポーズをミラーリングする (66ページ)

■ アニメーションを再生する (70ページ)

このチュートリアルで使用するアセット:

■ mia_servo.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。
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事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、次に Layout > Editing を選択し
ます。

MotionBuilderは、Editing レイアウトを使用して新しい 3D シーンを表
示します。このレイアウトには、このチュートリアルで作業するのに必要

なすべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_servoアセット(mia_servo.fbxファイル）を Viewer ウィンドウにド
ラッグして、表示されるコンテキストメニューから FBX Open > <No
Animation> を選択します。

以下の図のように、Mia (mia_servoアセット)という名前のモデルが Viewer
ウィンドウに表示されます。このキャラクタには、右肩のボーンを親とし、

Character Extension (キャラクタエクステンション)として追加されてい
る、「サーボアーム」が含まれています。

50 | 第 1 章 チュートリアル

http://www.autodesk.com/motionbuilder2013-documentation


Character Controls ウィンドウで、Mia が現在のキャラクタとして
Character メニュー(A)に既定で表示されます。
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A. Character Controlsの Characterメニュー

4 File > Save As を選択します。
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Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

ポーズを作成する

この手順では、キャラクタエクステンションを含むキャラクタにいくつかのボ

ディ全体のポーズを作成して、歩行サイクルを作成します。

キャラクタの配置:

1 Character Controls ウィンドウで、各足首エフェクタの上のプラス記号(+)
をクリックして、両方の補助ピボットを展開します。これにより、Mia の
足首が移動(T)および回転(R)でピンされます。

プラス記号をクリックして、足首エフェクタ(A、B)を展開します。

2 Ctrlキーを押しながらクリックして、手首エフェクタと足首エフェクタ

を選択します。
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エフェクタ A手首エフェクタ、B.足首エフェクタ

3 T および R エフェクタのピンオプションを無効にします。
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Effector Pinningオプション A. Tおよび Rエフェクタのピンが無効
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注: 回転が確実に無効になるように、R(回転ピン)のオンとオフをもう一度
切り替えなければならない場合があります。

キャラクタ表現のどのエフェクタにも T または R がないことを確認しま
す。

4 Character Controls ツールバーの Full Body キーイングモード( )が

有効になっていることを確認します。

この Full Body キーイングモードでは、ペーストしたポーズはキャラクタ
のボディ全体に配置され、キーフレームはすべてのエフェクタに配置され

ます。

5 Character Controls ウィンドウで、左肩エフェクタを選択します。

6 Viewer ウィンドウの上にカーソルを移動し、Rキーを押して、Mia の左腕
が体の脇の、より自然な位置に来るまでエフェクタを回転させます。

7 右肩エフェクタに対しても同じ操作を実行します。

8 Ctrl キーを押しながら両方の手首エフェクタをクリックし、Y 軸上で上方
向に移動して、肘を自然に曲げます。
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手首エフェクタを使用して手首を Y軸の上方向へ移動
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9 Viewer ウィンドウの空の領域をクリックし、手首エフェクタを選択解除し
て、キャラクタの側面が表示されるカメラビューを選択します。たとえ

ば、Ctrl + Rキーを押すと、Producer Right カメラビューに切り替える
ことができます。

Producer Rightカメラビュー

注: 見やすいように、適宜カメラビューを切り替えてください。

歩行サイクルの最初のポーズを作成するには:

1 Character Controls ウィンドウで、右足首エフェクタを選択し、膝が曲が
るように、足を(Z 軸上の)前方向およびやや上方向に移動します。

2 左足首エフェクタを選択し、Mia が歩いているように見えるように、Mia
の両足が離れて両膝が曲がるまで、左足首エフェクタを後方にスライドさ

せます。

注: 足首エフェクタピボットを選択して、Mia の足首を曲げることができ
ます。

3 Mia が自然に腕を振っているように、右肩エフェクタを選択し、右腕を後
方にわずかに回転させます。次に、左肩を選択して、左腕を前方に回転さ

せます。

58 | 第 1 章 チュートリアル



4 ヒップエフェクタを選択し、Mia の歩幅が中程度になるように、Mia のボ
ディを上方向または下方向に移動します。座標変換の結果、Mia がフロア
(床面)から浮いてしまった場合はいつでも、ヒップエフェクタを選択し、

Mia を下方向に移動できます。既定のフロアコントロールマーカーによ
り、Mia の足は自然に既定のフロアに合わせて動作します。

このポーズでは、Mia の右脚から前進歩行モーションが始まります(次の図
を参照)。

最初のポーズを作成できる状態

5 Resources ウィンドウで、Pose Controls タブをクリックし、Create 
をクリックします。

Pose ブラウザにポーズが追加されます。

キャラクタエクステンションの位置は、このポーズの Mia のボディの位
置に含まれます。

6 Pose ブラウザで Posesフォルダを展開し、ポーズを表示します。

7 作成したポーズを右クリックし、Rename を選択して名前を「Walk 01」
に変更します(B)。
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Pose Controls A.ポーズの作成、B. Poseブラウザの「Walk 01」ポーズ

歩行サイクルの 2つ目のポーズの作成:

1 次の図のように見えるように、Mia の脚と腕を配置します。

■ 右足首エフェクタを選択し、Mia の足が地面に着くまで後下方にスラ
イドさせます。

■ 次に、勢いを出すために、左足首エフェクタを選択し、Mia の背後の
位置まで後方にスライドさせます。

■ ヒップエフェクタを調整し、Mia の膝を不自然でない程度に曲げます。

2 Mia:ServoControl エフェクタを選択し、Mia の正面に来るようにサーボ
アームを移動します。

3 Mia:ServoControl エフェクタが選択されている状態で Asset Browser の
Properties タブをクリックし、Close_Open プロパティ(B)を使用してハサ
ミを半分開きます(次の図を参照)。

A.歩行サイクルの 2つ目のポーズ B. Close_Openプロパティで、ハサミを制御

60 | 第 1 章 チュートリアル



4 Pose Controls で Create をクリックし、このポーズに「Walk 02」
と名前を付けます(A)。

Pose Controls A. 2つ目のポーズの名前を「Walk 02」に変更

歩行サイクルの 3つ目(最後)のポーズの作成:

1 次の図のように見えるように、Mia の脚と腕を配置します。

2 Mia:ServoControl エフェクタを選択し、サーボアームを、Mia の前方ま
で、さらに伸ばします。

3 Mia:ServoControl が選択されている状態で、Properties ウィンドウの
Close_Open プロパティを使用してハサミをさらに開きます(B)。

このポーズでは、左脚は後方に移動し、サーボアームは前方に移動しま

す。これにより、歩行サイクルの前半の 1 歩が完成します。

A.歩行サイクルの 3つ目のポーズ B. The Close_Openプロパティ

4 Pose Controls で Create をクリックし、このポーズに「Walk 03」と名前
を付けます。
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現在、シーンには、3 種類のポーズがあります。3 つのポーズが、Pose ブ
ラウザにリストされています。

歩行サイクルの 3つポーズを作成した状態

ポーズを使ってアニメーションを作成する

次の手順では、先ほど作成した 3 種類のポーズを使用して、歩行サイクルを半
分作成します。さまざまなフレームでこれらのポーズにキーフレームを設定し

て、短い歩行アニメーションを作成します。

1 Character Controls ウィンドウで選択されているエフェクタをすべて選択
解除し、Full Body キーイングモードが選択されていることを確認します
(A)。
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Character Controls: A. Full Bodyキーイングモードを選択した状態
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2 Pose ブラウザで、[Walk 01]ポーズをダブルクリックして Mia にペースト
します。

Pose Controls: A.歩行サイクルの最初のポーズB. Miaに「Walk 01」ポーズをペー
ストした状態

Pose Controls ウィンドウの Gravity、Translation、および Rotation オプ
ションは、既定でアクティブに設定されています。つまり、ペーストした

ポーズの移動と回転は、カレントキャラクタの選択されたエフェクタの移

動および回転と一致します。Gravity オプションが有効なため、ペースト
元のポーズのオリジナルレベルで足が静止します(通常は床面の高さ)。

3 ヒップエフェクタを選択してから、Transport Controls のフレーム 0 に
移動します。

A.ヒップのエフェクタを選択 B.カレントフレームは 0
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4 Key Controls ウィンドウで、Type メニューから Auto を選択します。

5 Layer メニューから AnimLayer1 を選択し(A)、Flat をクリックして、フ
ラットなキーフレームを設定します(B)。

注: Ctrl+Kキーを押してもフラットなキーフレームを設定できます。

Key Controls A. AnimLayer1を選択 B. Flatキー

6 フレーム 4 に移動して、次の操作を実行します。

■ Walk 02 ポーズをダブルクリックして、Mia にペーストします。

■ [Ctrl]キーを押しながら [K]キーを押して、(平坦な)キーフレームを設
定します。

フレーム 4: A.歩行サイクルの 2つ目のポーズ B. Miaに[Walk 02]ポーズをペー
ストした状態

7 フレーム 8 に移動して、次の操作を実行します。

■ Walk 03 ポーズをダブルクリックして、Mia にペーストします。

■ [Ctrl]キーを押しながら [K]キーを押して、(平坦な)キーフレームを設
定します。
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フレーム 8: A.歩行サイクルの 3つ目のポーズ B. Miaに[Walk 03]ポーズをペー
ストした状態

8 アニメーション全体を通してタイムスライダインジケータをドラッグし、

ここで作成した 1 歩を確認します。

3 つのキーフレーム間の補間によって 1 歩の動きが作成されます。

ポーズをミラーリングする

次の手順では、Pose ブラウザから 3 つのポーズをミラーリングして、後半の歩
行サイクルを作成します。オリジナルのポーズの後にミラーリングしたポーズに

キーフレームを設定して、短い歩行アニメーションを完成させます。

1 Pose Controls ウィンドウで、M (Mirror) ボタンをオンにします(A)。
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Pose Controls A. Mirrorをオン

2 フレーム 12 に移動して、次の操作を実行します。

■ 「Walk 01」ポーズをダブルクリックします(A)。

「Walk 01」ポーズがミラーリングされ、キャラクタにペーストされま
す(Bポーズをミラーペーストしたので、左脚が前に、右脚が後ろにな
り、反対側の歩行サイクルが続けられます。

■ [Ctrl]キーを押しながら [K]キーを押して、(平坦な)キーフレームを設
定します。

フレーム 12 A.後半の歩行サイクルの最初のポーズ、B. Miaに「Walk 01」ポー
ズをペーストした状態

3 フレーム 16 に移動して、次の操作を実行します。

■ 「Walk 02」ポーズをダブルクリックします(A)。
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「Walk 02」ポーズがミラーリングされ、キャラクタにペーストされま
す(B)。

■ [Ctrl]キーを押しながら [K]キーを押して、(平坦な)キーフレームを設
定します。

フレーム 16 A.後半の歩行サイクルの 2つ目のポーズ、B. Miaに「Walk 02」
ポーズをペーストした状態

4 フレーム 20 に移動して、次の操作を実行します。

■ 「Walk 03」ポーズをダブルクリックします(A)。

「Walk 03」ポーズがミラーリングされ、キャラクタにペーストされま
す(B)。

■ [Ctrl]キーを押しながら [K]キーを押して、(平坦な)キーフレームを設
定します。
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フレーム 20: A.後半の歩行サイクルの 3つ目のポーズ B. Miaに「Walk 03」
ポーズをペーストした状態

アニメーションは 6 つのキーフレームから構成されます。最初の 3 つ
のキーフレームは、キャラクタの左側にミラーリングされて最後の 3
つのキーフレームに使用され、完全な歩行動作を作成します。完全なア

ニメーションサイクルを完成するには、テイクの始点と終点を同じに

する必要があります。

5 Transport Controls の Action タイムラインで、フレーム 0 のキーフレー
ムを選択し、Cキーを押しながらキーフレームをフレーム 24 にドラッグ
します。

フレーム 0 のキーフレームがフレーム 24 にコピーされます。

これでアニメーションの開始と終了の位置が同じになり、サイクルが完成

します。
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アニメーションを再生する

1 Transport Controls ウィンドウで、Action タイムラインをクリックし、
[Ctrl]+[Shift]+[A]キーを押して、Action タイムラインのアニメーション
の 24 フレームすべてにフレームします。

2 Loop (A)、Play の順にクリックします。

アニメーションにフレーム A. Loopオプション

アニメーションを再生すると、各ループは完全な歩行サイクルを表示しま

す。

このアニメーションでは、動きがぎこちなく、足がフロア(床面)の上を滑

る場合があります。FCurves ウィンドウでアニメーションのファンクショ
ンカーブを調整すると、動きを滑らかにすることができます。

まとめ

このチュートリアルでは、キャラクタにポーズを作成し、作成したポーズのキー

フレームをさまざまなポイントに設定し、歩行サイクルを作成しました。

注: Story ウィンドウを使用した歩行サイクルを作成したい場合は、ループを作
成してください。

次のチュートリアル、キャラクタアニメーションをリターゲットする (70ペー
ジ)では、あるキャラクタから別のキャラクタへ、アニメーションやキャラクタ

エクステンションのターゲットを再設定します。

キャラクタアニメーションをリターゲットする

このチュートリアルでは、キャラクタライズ済みのキャラクタから別のキャラク

タにアニメーションをリターゲットする手順を説明します。ソースキャラクタ

にはキャラクタエクステンションが含まれ、ターゲットキャラクタには含まれ

ないため、キャラクタエクステンションのリターゲッティングも必要です。
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このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (71ページ)

■ キャラクタアニメーションを保存する (73ページ)

■ シーンを作成する (76ページ)

■ キャラクタアニメーションをロードする (77ページ)

■ アニメーションを再生する (82ページ)

このチュートリアルで使用するアセット:

■ mia_fk_runstopturn.fbx
■ Gremlin.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、次に Layout > Editing を選択し
ます。

MotionBuilderは、Editing レイアウトを使用して新しい 3D シーンを表
示します。このレイアウトには、このチュートリアルで作業するのに必要

なすべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。
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3 図のように mia_fk_runstopturnアセット(mia_fk_runstopturn.fbxファ
イル)を Viewer ウィンドウにドラッグして、表示されるコンテキストメ
ニューから FBX Open > All Takes を選択します。

Mia という名前のモデルが、「サーボアーム」キャラクタエクステンショ
ンと一緒に Viewer に表示されます。

Mia_fk_runstopturnアセットをシーンにドラッグ

4 File > Save As を選択します。

Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

7 Transport Controls で、Play をクリックして(A) Mia キャラクタのアニメー
ションを確認します。

Transport Controls A. Playボタン
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キャラクタアニメーションを保存する

次の手順では、Save Character Animation オプションを使用してキャラクタア
ニメーションを保存します。これによりLoad Character Animation オプション
を使用して Mia のアニメーションを別のキャラクタに読み込みできます。

1 Character Controls メニューボタンからFile > Save Character Animation
を選択します。
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Character Controlsメニュー A. Save Character Animationオプション
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2 キャラクタアニメーションを保存する場所に移動し、ファイル名を入力し

て、Save をクリックします。

Save Fileダイアログボックス

3 表示される Save Character Animation Options ダイアログボックスで、
Save Control Rig オプションと Save Character Extensions オプションを
アクティブにして、Save をクリックします。
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Save Character Animation Optionsダイアログボックス

アニメーションとキャラクタエクステンションが .fbxファイルとして保
存されます。

シーンを作成する

次は、シーンを作成します。

1 Ctrl+Nキーを押してシーンを作成します。

2 表示される Save changes ダイアログボックスで Don’t Save をクリック
します。

Save changesダイアログボックス
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3 Asset Browser から Gremlinアセットをシーンにドラッグし、FBX Open
> <No Animation> を選択します。

Gremlinをシーンにドラッグします。

キャラクタアニメーションをロードする

次に、前の手順で保存したキャラクタアニメーションをロードします。

1 Character Controls ウィンドウでFile > Load Character Animation を選
択します。
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Character Controls A. Load Character Animationオプション
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2 このチュートリアルで先ほど保存した .fbxファイルに移動してこれを選択
し、Open をクリックします。

Load Character Animation Options ダイアログボックスが表示されます。

3 選択する設定:

■ Load Technique 領域(A)で、Plot to Control Rig オプションをオンに
します。

■ Control Rig 領域で、Replace Control Rig オプション(B)をオンにしま
す。

■ Control Rig 領域で、Reset Control Rig’s Rotation DOF オプション(C)
をオンにします。

■ Control Rig 領域で、Remove Constraint Reference オプション(D)が
オンになっていることを確認します。

■ Character Extensions 領域で、Process Animation オプション(E)をオ
ンにします。

■ Character Extensions 領域で、Copy Missing Character Extensions オ
プション(F)をオンにします。
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Load Character Animation Optionsダイアログボックスでの設定

4 Open をクリックします。

Mia のアニメーション、コントロールリグ、キャラクタエクステンショ
ンが Gremlin キャラクタにロードされます。
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Miaのアニメーションとコントロールリグが Gremlinキャラクタにロードされま
す。

Mia のサーボアームは、右肩の FK エフェクタにペアレント化されている
ため、サーボアームは同じように Gremlin キャラクタにアタッチされま
す。
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アニメーションを再生する

結果のアニメーションを再生します。

1 Transport Controls の Play をクリックしてアニメーションを再生します
(A)。

A. Miaのアニメーションを使用する Gremlin B. Gremlinのコントロールリグ

サーボアームとアニメーションの両方がどのように Gremlin キャラクタ
上に転送されるかに注意してください(A)。Gremlin のオリジナルのコント
ロールリグがシーン中央に残されます(B)。これは、Load Character
Animation Options ダイアログボックスの Replace Control Rig を選択し
たため発生する現象です。Gremlin のコントロールリグが Mia のコント
ロールリグと置き換えられています。

2 Scene Browser で Control Rigs を展開し、Gremlin Rig (Gremlin のオリ
ジナルのコントロールリグ)を右クリックして、Delete を選択しシーンを
クリーンアップします。
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Scene Browser: A.コンテキストメニューの Deleteボタン

まとめ

このチュートリアルでは、あるキャラクタライズされたキャラクタから、別の

キャラクタにアニメーションをリターゲットして、ソースキャラクタからター

ゲットキャラクタにキャラクタエクステンションを転送しました。

次のチュートリアルキャラクタアニメーションを編集する (83ページ)では、オ
リジナルのアニメーションからレイヤ上のアニメーションを編集した後、すべて

のレイヤをマージします。

キャラクタアニメーションを編集する

このチュートリアルでは、アニメーションレイヤを作成して、アニメーション

を変更する手順を説明します。キャラクタのコントロールリグにプロット済み

のアニメーションを 2 つのレイヤで修正して、オリジナルのアニメーションと
修正したアニメーションを結合します。

このチュートリアルでは、以下の方法について説明します。

■ シーンを準備する (84ページ)

■ キャラクタエクステンションのアニメーションを変更する (86ページ)

■ 頭部のアニメーションを変更する (91ページ)

■ 作成されたテイクを再生する (96ページ)

キャラクタアニメーションを編集する | 83



このチュートリアルで使用するアセット:

■ mia_runstopturn.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

シーンを準備する

以下の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始
するのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、次に Layout > Editing を選択し
ます。

MotionBuilderは、Editing レイアウトを使用して新しい 3D シーンを表
示します。このレイアウトには、このチュートリアルで作業するのに必要

なすべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_runstopturnアセット(mia_runstopturn.fbxファイル）を Viewer
ウィンドウにドラッグして(A)、表示されるコンテキストメニューから FBX
Open > run_stop_turn180 を選択します。

Mia という名前のモデルが Viewer に表示されます(B)。
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A. mia_runstopturnアセット B.シーンにロードされた Miaキャラクタ

4 File > Save As を選択します。

Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

7 Viewer ウィンドウ内をクリックし、Ctrl+Rを 2 回押して、Producer Left
カメラに切り替えます。ズームアウトして、グリッド全体を表示します。

Producer Leftカメラビュー
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キャラクタエクステンションのアニメーショ

ンを変更する

次の手順では、アニメーションを作成して、サーボアームキャラクタエクステ

ンションのアニメーションを変更します。

1 テイク全体を再生して（Ctrl+スペースバー）、すべてのモーションを確
認します。サーボアームに特に注目してください。

現在、サーボアームは、赤いワイヤフレームエフェクタの方向を指しな

がら、Mia の前で細かい上下動を繰り返しています。このエフェクタは
Mia の肩にペアレント化されているので、Mia が走る動作につれてサーボ
アームが跳ねるように動きます。

2 Ctrl+Homeキーを押してテイクの先頭に戻り、もう一度フレーム 40 まで
再生します。

フレーム 40での Mia

3 Key Controls でレイヤメニューから AnimLayer1 を選択します(A)。

Key Controls A. AnimLayer1を選択

86 | 第 1 章 チュートリアル



これにより、BaseAnimation レイヤにオリジナルのアニメーションを保持
しつつ、アニメーションレイヤにキーフレームを設定できます。

4 Mia:ServoControl エフェクタを選択し(A)、Key Controls の Zero をクリッ
クしてフレーム 40 にゼロキーフレームを設定します(B)。

フレーム 40 A. Mia:ServoControlエフェクタ B. Zeroキーフレームボタン

5 Mia:ServoControl エフェクタを選択した状態のまま、フレーム 120 に移
動し、ゼロキーフレームを設定します。
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フレーム 120 A. Mia:ServoControlエフェクタを選択 B. Zeroキーフレームボタン

6 フレーム 64 に移動します。

このフレームで、Mia がサーボアームを上げるようにアニメーションを変
更します。

フレーム 64

7 次の操作を行います。

■ Viewer ウィンドウ内をクリックし、Tキーを押して Translation モー
ドをアクティブにします。

■ Viewer ウィンドウの下部分で、Translation XYZ の値を 200、-30、10
に設定します(A)。
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■ キーフレームを設定します(B)。

フレーム 64 A. Translation XYZ値を設定 B. Keyボタン

8 フレーム 96 に移動して、次の操作を実行します。

■ Mia:ServoControl エフェクタの Translation XYZ の値を 45、16、14
に設定します(A)。

■ キーフレームを設定します(B)。

キャラクタアニメーションを編集する | 89



フレーム 96 A. Translation XYZの値を設定 B. Keyボタン

9 フレーム 104 に移動して、次の操作を実行します。

■ Translation XYZ の値を 35、-25、68 に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 104 A. Translation XYZ値を設定 B. Keyボタン
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10 アニメーションを再生します。

Mia が速度を緩めて振り返る際に、サーボアームを上げる動作になりまし
た。

頭部のアニメーションを変更する

次の手順では、別のレイヤを使用して、アニメーションを改善します。Mia が
走っている間、停止したときと振り向く直前に頭部が動くようにします。

1 フレーム 24 に移動します。

このフレームでは、Mia の頭部は走っている方向にまっすぐ向いていま
す。このモーションを変更して、Mia が頭部を動かすようにします。

フレーム 24での Mia

2 Key Controls ウィンドウで、Layer メニューから New Layer を選択し(A)、
頭部のアニメーションを修正するためのレイヤを作成します。

Key Controlsウィンドウ A. Layerメニュー > New Layerオプション

「AnimLayer2」という名前のレイヤが追加されます。
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3 Character Controls ウィンドウで頭部のエフェクタを選択し(A)、Body Part
キーイングモードに切り替えます(B)。
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Character ControlsウィンドウA.頭部のエフェクタが選択されているB. Body Part
キーイングモードが選択されている
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ボディ全体ではなく頭部だけにキーフレームを設定すれば良いため、この

レイヤでアニメーションを作成するときは、Body Part キーイングモード
を使用できます。

4 Key Controls で Zero をクリックして、ゼロキーフレームを設定します
(A)。

Key Controls A. Zero keyframeボタン

5 フレーム 120 に移動して、別のゼロキーフレームを設定します。

フレーム 120 A. Zeroキーフレームボタン

6 フレーム 48 に移動して、次の操作を実行します。

■ 頭部のエフェクタを選択したままの状態で、Rotation モードをアクティ
ブにします(Viewer ウィンドウ内でクリックして R を押します)。

■ Viewer ウィンドウの下部分で、Rotation XYZ の値を 35、0、2 に設定
します(A)。

■ キーフレームを設定します(B)。
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フレーム 48 A. Rotation XYZの値を設定 B. Keyボタン

7 フレーム 72 に移動して、次の操作を実行します。

■ Rotation XYZ の値を 42、0、-5 に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 72 A. Rotation XYZの値を設定 B. Keyボタン
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8 フレーム 84 に移動して、次の操作を実行します。

■ Rotation XYZ の値を 30、-5、0 に設定します(A)。

■ キーフレームを設定します(B)。

フレーム 84 A. Rotation XYZの値を設定 B. Keyボタン

9 頭部のエフェクタを選択解除し、アニメーションを再生します。

Mia が走ると、頭部が動きます。

作成されたテイクを再生する

テイクを再生してアニメーションを確認します。

サーボアームを上げ、頭部を動かすアニメーションが、走って方向転換をする

Mia のオリジナルのアニメーションにマージされています。

まとめ

このチュートリアルでは、2 つのレイヤにキーフレームを設定して元のアニメー
ションを変更しました。次のチュートリアル、ループを作成する (97ページ)で
は、Story ウィンドウを使用した歩行サイクルの作成方法について学びます。
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ループを作成する

このチュートリアルでは、キャラクタをアニメートし、Story ウィンドウで歩行
サイクルを作成する手順について説明します。

このチュートリアルの主な項目は次のとおりです。

■ シーンを準備する (98ページ)

■ キャラクタトラックを作成する (99ページ)

■ ポーズを作成する (103ページ)

■ クリップをマッチさせる (107ページ)

■ クリップを処理する (111ページ)

■ 歩行サイクルをテストする (114ページ)

このチュートリアルで使用するアセット:

■ mia_servo.fbx
■ walkaround.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。
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シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、Layout > Story を選択します
(Ctrl+Shift+5キー)。

MotionBuilderは、Story レイアウトを使用して新しい 3D シーンを表示
します。このレイアウトには、このチュートリアルで作業するのに必要な

すべてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_servoアセット (mia_servo.fbxファイル) を Viewer ウィンドウにド
ラックして、次に FBX Open > No Animation を選択します。

mia_servoアセットが、Viewer ウィンドウに T-スタンスで表示されます。

T-スタンスの Miaとサーボアーム

4 File > Save As を選択します。

Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。
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既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

キャラクタトラックを作成する

次の手順では、Story ウィンドウでキャラクタトラックを作成し、トラックが作
用するキャラクタを定義し、アニメーションを追加します。

1 Story ウィンドウで、Action Track リストを右クリックし(A)、コンテキス
トメニューから Insert > Character Animation Track を選択します。

Storyウィンドウ A. Action Trackリスト

Character Animation トラックが追加されます(A)。

Storyウィンドウ A.キャラクタトラック

2 トラックの Character メニューで Mia を選択します(A)。
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Storyウィンドウ A. Characterメニューで Miaを選択します。

3 Asset Browser からキャラクタトラックに walkaround.fbxをドラッグし
ます。

キャラクタトラックにドラッグされている walkaround.fbxアセット。

4 フレーム 0 から始まるようにクリップをドラッグします。クリップはフ
レーム 78 で終わらせる必要があります。

キャラクタトラックのフレーム 0にドラッグされるクリップ。
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注:

キャラクタトラックで Ctrl キーを押しながらドラッグするとズームし、
Shift キーを押しながらドラッグするとパンします。

5 アニメーションを再生します(Ctrl+スペースバー)。

フレーム 0 では、キャラクタの右足が前、左足が後ろになっています。フ
レーム 78 で、Mia は進む方向を変えます。この時点でアニメーションを
ループすると、歩行サイクル内にジャンプが生じてしまいます。

6 フレーム 32 に移動します。このフレームでは、Mia の右足は地面に着地
していて、左足はわずかに持ち上がっています。

Mia を正面から確認するためカメラビューを変更します。

フレーム 32での Mia。

7 クリップが選択されたままの状態で、Razor ボタンをクリックします(A)。

Storyウィンドウ A. Razorボタン
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クリップはフレーム 32 で 2 つに切断されます。

オリジナルのクリップが 2つに切断されました。

8 フレーム 60 に移動します。このフレームでは、Mia はフレーム 32 とほぼ
同じポーズになっています。

フレーム 60での Mia。

9 2 番目のクリップを選択していない場合はそれを選択し、Razor ボタンを
クリックします。

2 番目のクリップがフレーム 60 で切断され、クリップは 3 つになります。

キャラクタトラック内の 3つのクリップ

10 必要なのは中央のクリップだけなので、Ctrl キーを押しながら 1 番目のク
リップをクリックして 1 番目のクリップと 3 番目のクリップを選択した
後、Delete キーを押します。

11 フレーム 0 で始まるように残ったクリップをドラッグします。
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クリップはフレーム 0で始まり、フレーム 28で終わります。

ポーズを作成する

1 フレーム 0 に移動します(Ctrl+Home)。

2 Character Controls ウィンドウで、Current Character から Mia が選択さ
れていることを確認し(A)、ヒップエフェクタを選択します(B)。

ループを作成する | 103



Character Controlsウィンドウ A.ヒップのエフェクタを選択した状態

3 Asset Settings ウィンドウで、Pose Controls タブをクリックします。
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4 Pose Controls で Create をクリックし(A)、Poses フォルダを展開して、作
成したポーズを確認します。ポーズの名前は既定で「Mia Pose」となって
います(B)。

Pose Controlsウィンドウ A. Createボタン B. Mia Pose

5 フレーム 28 に移動して、次の操作を実行します。

■ Story ウィンドウで、キャラクタトラックの Accept Keys オプション
をアクティブにします(A)。Animate オプションがアクティブの場合、
ポーズのトラックへのペーストしかできません。

キャラクタトラック A. Animateオプションをアクティブにします。

■ Character Controls ウィンドウで Right Ankle エフェクタ(A)を右ク
リックし、表示されるメニューから RightAnkleEffector を選択します。
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■ Pose Controls ウィンドウで Paste をクリックします(A)。

106 | 第 1 章 チュートリアル



Pose Controlsウィンドウ A. Pasteボタン

1 フレームのクリップがフレーム 28 のキャラクタトラックに表示されま
す。

このクリップには、ペーストしたポーズのデータが含まれます。Mia の歩
行開始と歩行終了のポーズがまったく同じになります。

キャラクタトラック A.フレーム 28の新しいクリップ

6 ジョグ([J]キーを押しながらドラッグ)するか、[Ctrl]+左矢印キーと[Ctrl]+
右矢印キーを使用して、アニメーション内をフレームごとにゆっくり移動

します。アニメーションの始めと終わりは同じポーズですが、始めと終わ

りのクリップの間に小さなジャンプがあります。次の手順でジャンプを削

除します。

クリップをマッチさせる

次の手順では、2 つのクリップをマッチさせてブレンドし、アニメーション内の
ジャンプを削除します。

1 トラックの下の空いている部分をクリックし、A を押してクリップをズー
ムインします。

2 2 番目のクリップを選択します。
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キャラクタトラック A. 2番目のクリップが選択されています。

3 Right Ankle エフェクタが Character Controls ウィンドウで選択されたま
まの状態であることを確認します(A)。
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Character Controlsウィンドウ A. Right Ankleエフェクタ

4 Story ウィンドウで Match Options ボタンをクリックします(A)。
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Storyウィンドウ A. Match Optionsボタン

5 表示される Match Options ダイアログボックスで OK をクリックします
(A)。

Match Optionsダイアログボックス A. OKボタン

6 MotionBuilder のメニューバーから Window > Asset Settings を選択し
Story ウィンドウで 2 番目のクリップをダブルクリックして設定を表示し
ます。

7 Asset Settings で、In フィールド(A)の値を 23 に設定します。
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Asset Settingsウィンドウ A. Inポイントがフレーム 29に設定されています。

8 Asset Settings ウィンドウの Out フィールドに値 29 を入力します。

9 2 番目のクリップはフレーム 23 で始まるようになり、フレーム 29 で終わ
るように 1 番目のクリップと相互にブレンドします。このブレンドによ
り、クリップ間の移行が少しだけ滑らかになります。

2番目のクリップはフレーム 23で始まり、フレーム 29で終わります。

10 アニメーションを再生します。Mia が歩き、歩行開始とと歩行終了のポー
ズは同じになります。

クリップを処理する

次の手順では、2 つのクリップを処理して単一のクリップとして保存します。そ
の後、この新しいクリップを使用して、別のキャラクタをアニメートします。

1 キャラクタトラックのキャラクタ名の近くで右クリックし、コンテキスト

メニューから Frame Start/End を選択します(A)。 クリップの長さに合わ
せてタイムレンジのサイズが変更されます。
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キャラクタトラックのコンテキストメニュー A.選択された[Frame Start/Endオプ
ション。

2 キャラクタトラックをもう一度右クリックし、コンテキストメニューか

ら Process Track/Subtracks To New Clip オプションを選択します(A)。

キャラクタトラックのコンテキストメニュー A. Process Tracks/Subtracks To
New Clipオプション

3 表示される Process Track and Subtrack ダイアログで、Process Rate を 24
FPS に変更します。OK をクリックします。
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Process Track and Subtracksダイアログボックス

4 表示される Save Clip ダイアログボックスで、新しいクリップを
mia_walk_cycle.fbxという名前で保存します。
このチュートリアルを完了するには、保存したクリップが必要になります。

Save Clipダイアログボックス

Story ウィンドウに、新しい mia_walk_cycle.fbxクリップを含む 2 番目
のキャラクタトラックが表示されます(A)。

Storyウィンドウ A.新しい mia_walk_cycle.fbxクリップ
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歩行サイクルをテストする

次の手順では、新しい歩行サイクルクリップをテストして、滑らかにループす

るかどうかを確認します。

1 (A)のようにLoop/Scale オプションが Loop に設定されていることを確認
します。

Storyウィンドウ A. Loop/Scaleオプションは Loopに設定されています。

2 キャラクタトラックをズームアウトし、mia_walk_cycle クリップの最後
をフレーム 116 まで伸ばします(A)。クリップは 4 回ループされます。

キャラクタトラック A.フレーム 116まで伸ばしたクリップ

3 任意のキャラクタトラックを右クリックし、コンテキストメニューから

Frame Start/End を選択します。

4 1 番目のキャラクタトラックの Mute ボタン(A)をクリックして、トラック
を無効にします。

キャラクタトラック A.ミュートを選択

5 アニメーションを再生します。Mia は、140 フレームの間、滑らかに歩行
します。
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まとめ

このチュートリアルでは、短いアニメーションクリップから、ループする歩行

サイクルを作成しました。次のチュートリアル「クリップを操作する (115ペー
ジ)」では、クリップを修正することでキャラクタアニメーションを編集する方

法を学習します。

クリップを操作する

このチュートリアルでは、クリップを操作してキャラクタアニメーションを変

更するために必要な手順について説明します。

このチュートリアルでは、以下の方法について説明します。

■ シーンを準備する (116ページ)

■ 方向転換を作成する (117ページ)

■ 2 つのクリップをブレンドする (121ページ)

■ クリップを追加する (123ページ)

■ クリップをマッチさせる (124ページ)

このチュートリアルで使用するアセット:

■ mia_story.fbx
■ run_boom.fbx

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。
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シーンを準備する

次の手順では、MotionBuilderシーンを準備し、このチュートリアルを開始す
るのに必要なファイルを開きます。

1 メニューバーから File > New を選択し、Layout > Editing を選択します
(Ctrl+Shift+3キー)。

MotionBuilderは、Editing レイアウトを使用して新しいシーンを表示し
ます。このレイアウトには、このチュートリアルで作業するのに必要なす

べてのウィンドウが表示されます。

2 Asset Browser で Tutorialsフォルダをクリックします。

3 mia_storyアセット(mia_story.fbxファイル)を Viewer ウィンドウにド
ラッグして(A)、次に FBX Open > All Takes を選択します。

Mia という名前のモデルが Viewer ウィンドウに表示され(B)、Mia はト
ラックの Character メニューで選択されています。

注: グリッドの端の Mia を表示するには、Viewer ウィンドウをズームア
ウトする必要がある場合があります。

A. mia_storyアセット B.シーンにロードされた Miaモデル

Story ウィンドウには、クリップを含む、Clip_Run_Loop という名前のト
ラックがあります。
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4 File > Save As を選択します。

Save File ウィンドウが表示されます。

5 ファイルを保存するディレクトリ(既定のMotionBuilderTutorialsディレ
クトリ以外のディレクトリ)に移動し、Save をクリックします。

Save Options ダイアログボックスが表示されます。

6 Save をクリックします。

既定のMotionBuilderTutorialsディレクトリ以外のディレクトリにファイ
ルを保存することで、元の .fbxファイルが上書きされません。

7 Story ウィンドウで、Story ボタン(A)がまだオンになっていない場合は、
それを選択してから Character トラック (B)をクリックし、[A]キーを押し
てクリップをフレームします。

Storyウィンドウ A. Storyボタンを選択します。B. Characterトラックに 1つのク
リップが表示されています。

8 アニメーションを再生します(Ctrl+スペースバー)。すべてのアニメーショ
ンを確認するには、Viewer ウィンドウでズームアウトする必要があるこ
とがあります。

方向転換を作成する

以下の手順では、クリップを 2 つに切断し、次にゴーストクリップベクトルを
回転して Mia を走らせながら方向転換させます。

1 フレーム 11 に移動します。

このフレームで、以下の図のように、Mia の左足は地面に着地していま
す。
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フレーム 11での Mia

2 Story ウィンドウで、次の図のようにクリップ(B)を選択し、Razor ボタン
(A)をクリックします。

Storyウィンドウ A. Razorボタン B.選択したクリップ

クリップがフレーム 11 で 2 つのクリップに切断されます(A)。

キャラクタトラック A.クリップがカレントタイムで 2つのクリップに切断される

3 次の図のように、Viewer ウィンドウで X-Ray 表示モードに切り替え、キャ
ラクタトラック(A)の Show/Hide Ghost オプションがアクティブになって
いることを確認します(A)。
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キャラクタトラック A. Show/Hide Ghostオプション

4 フレーム 0 に移動します(Ctrl+Home)。

Show/Hide Ghost オプションがアクティブな場合、次の図のように、
Viewer ウィンドウにゴーストが表示されます。

クリップベクトルゴーストは、各クリップの最初と最後を表します。ク

リップごとに、選択して操作できる 1 つのクリップベクトルゴーストが
あります(B および C)。

フレーム 0での Mia A.モデルゴースト B. 1番目のクリップのゴーストクリップ
ベクトル C. 2番目のクリップのゴーストクリップベクトル

5 Story ウィンドウで、2 番目のクリップが選択されていない場合はそれを選
択します(A)。

キャラクタトラック A. 2番目のクリップは選択されています。

Viewer ウィンドウで、選択したクリップのゴーストクリップベクトルも
選択されます。

6 Viewer ウィンドウでクリックし、キーボードショートカット Rキーを押

します。

以下の図のように、選択したクリップベクトルゴーストの一端に回転リ

ングが表示されます。

クリップベクトルの同じポイントにリングが表示されない場合は、クリッ

プベクトルのインポイントをダブルクリックして選択します。
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A.回転リング B. 2番目のゴーストクリップベクトルの Inポイント

7 以下の図のように(A)、Viewer ウィンドウの Rotation Y-axis フィールドに
値 -70 を入力します。

クリップベクトルが Mia の右の方を向きます(B)。

ヒント:

緑色の回転リングをドラッグして、クリップベクトルを手動で回転するこ

ともできます。
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A. Rotation Y-axisフィールド B.ゴーストクリップベクトルが回転しています。

8 Viewer ウィンドウ内で Jキーを押しながらドラッグし、フレーム 8 から
16 までをゆっくりした速度でジョグします。

Mia は走らせながら方向転換しますが、フレーム 11 で Mia の足がわずか
にジャンプしています。このジャンプを削除するには、クリップをブレン

ドする必要があります。

2 つのクリップをブレンドする

以下の手順では、2 つのクリップをブレンドして、Mia が方向転換するときに発
生するアニメーションのジャンプを削除します。

1 Story ウィンドウで Loop オプションがアクティブになっていることを確
認します(A)。
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Storyウィンドウ A. Loopに設定された Loop/Scaleオプション

2 ユーザインタフェースの右下にある Asset Settings ウィンドウ内で、1 つ
目のクリップをダブルクリックして設定を表示します。

3 Asset Settings で、Out フィールド(A)の値を 15 に設定します。

Asset Settingsウィンドウ A. 15に設定された Outフィールド

以下の図のように(A)、1 番目のクリップが 2 番目のクリップとオーバー
ラップし、相互にブレンドされます。

キャラクタトラック A.相互にブレンドされたクリップ

4 アニメーションを再生します。

フレーム 11 でのジャンプが解消されました。
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クリップを追加する

以下の手順では、Story ウィンドウのキャラクタトラックにクリップを追加しま
す。

1 キャラクタトラックの下の空白を Ctrlキーを押しながらドラッグしてか

ら、Shift キーを押しながらドラッグしてズームアウトし、クリップの横
に空間を作ります。

2 Asset Browser の Tutorialsフォルダから、クリップの右側のキャラクタ
トラックの空白の部分に run_boom.fbxファイルをドラッグします。

キャラクタトラックに追加された run_boom.fbxクリップ

3 フレーム 36 から始まるようにクリップをドラッグします。

注:

以下の図のように、2 番目のクリップの最後に揃えて配置する必要があり
ます。

新しいクリップはフレーム 36から始まります。

4 新しいクリップを選択解除し、次にキャラクタトラックを右クリックし、

コンテキストメニューから Frame Start/End を選択します。

5 アニメーションを再生します(Ctrl+スペースバー)。

Mia は、走って方向転換しますが、アニメーションにジャンプしてしまう
場所があるため、爆風を受けたかのように前方に投げ出されます。
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クリップをマッチさせる

以下の手順では、最後のクリップを前のクリップに一致させて、アニメーション

内のジャンプを削除します。

1 フレーム 0 に移動します。

2 Viewer ウィンドウで、Schematic ビューに切り替え、Mia:RightFoot ノー
ドを選択します(A)。

このノードは Mia の右足を表しており、マッチさせるオブジェクトとして
使用されます。

Schematicビュー A.選択された Mia:RightFootノード

3 Producer Perspective カメラビューに切り替えます。

4 Story ウィンドウで、3 番目のクリップを選択し(A)、Match Options ボタ
ンをクリックします(B)。

Storyウィンドウ A.選択された 3番目のクリップ B. Match Optionsボタン
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5 次の図のように、表示される Match Options ダイアログボックスで、選
択されていない場合は Match Object メニュー(A)で Mia:RightFoot を選択
し、To Previous Clip (B)と Between Previous Clip and Selected Clip (C)
を選択します。

Match OptionsダイアログボックスA. Match Object B. Match Clip C. Match Time

Translation オプションと Rotation オプションはすでに選択されていま
す。

6 OK をクリックします。

最後のクリップベクトルが、前のクリップとマッチするように移動しま

す。

7 Mia:RightFoot を選択解除します(Shift+D キー)。

8 アニメーションを再生します。

Mia は走って方向転換し、前方に投げ出されます。アニメーションのジャ
ンプが解消されました。

まとめ

このチュートリアルでは、連続するアニメーションのクリップを 2 つに切断し、
1 つのクリップベクトルゴーストを回転してキャラクタを走らせながら方向転
換させました。さらに異なるアニメーションの別のクリップを追加し、3 つのク
リップをすべて、1 つのシームレスなアニメーションシーケンスへとブレンド
しました。

次のチュートリアル(「MotionBuilder に 3ds Max ファイルを読み込みする(126
ページ)」)では、3ds Max のスケルトンとキャラクタをMotionBuilderに書き
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出し、コントロールリグを追加し、スケルトンとキャラクタをキャラクタライ

ズします。さらに、MotionBuilderでキャラクタをアニメートしてから、キャ
ラクタとアニメーションを 3ds Max に書き出します。

MotionBuilderに 3ds Max ファイルを読み込み
する

このチュートリアルでは、3ds Max で作成したキャラクタを書き出し、
MotionBuilderに読み込み、完全に編集可能なアニメートされたキャラクタと
して 3ds Max に再度書き出す方法について説明します。

注: このチュートリアルでは、執筆時点での最新バージョンの 3ds Max、
MotionBuilder、3ds Max FBX プラグインソフトウェア製品を使用しています。

このチュートリアルでは、3ds Max で作成された次の 3 種類のアニメート可能
なスケルトンを扱います。また、これらのスケルトンをMotionBuilderに読み
込み、FBX フォーマットを使用してアニメートする方法も説明します。

■ 3ds Max の標準的なボーンシステムのスケルトン

■ Biped システムのスケルトン

■ スケルトンがバインドされているスキンキャラクタ

各自のニーズに合った 3ds への送信手順を選んでください。あるいは、
MotionBuilderと 3ds Max の相互運用についてより深く学びたい方は、すべて
のチュートリアルを行うことをお勧めします。

このチュートリアルのセットでは、以下の方法について説明します。

■ 2 種類の 3ds Max スケルトンと 3ds Max キャラクタを書き出し、
MotionBuilderに読み込みする

■ MotionBuilderでコントロールリグを追加して、スケルトンとキャラクタを
キャラクタライズする

■ MotionBuilderでキャラクタをアニメートし、3ds Max に読み込みするため
の準備を行う

このチュートリアルの主なトピックは次のとおりです。

■ 動作環境 (127ページ)

■ 3ds Max のスケルトン (128ページ)
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■ 3ds Max の Biped (141ページ)

■ 3ds Max のキャラクタ (154ページ)

■ 3ds Max のキャラクタを MotionBuilder でアニメートする (162ページ)

注: このチュートリアルの手順ではMotionBuilderのキーボードショートカッ
トを使用していますが、MotionBuilderのメニューバーから Settings > Keyboard
Configuration > 3ds Max を選択することで、MotionBuilder で 3ds Max のキー
ボードショートカットを使用することもできます。MotionBuilder Help の「キー
ボードショートカット」のMotionBuilderの「3ds Max キーボードショート
カット」を参照してください。

注: MotionBuilderでは他のソフトウェアから読み込まれたファイルで使用され
るネイティブのフレームレートを採用します。本チュートリアルでは、3ds Max
からスケルトンを読み込むと、MotionBuilderがその既定の 24 フレーム/秒(FPS)
のフレームレートを 3ds Max ファイルのフレームレート(30 FPS)に一致するよ
うに変更します。本チュートリアルを終えると、MotionBuilderは、元のフレー
ムレート 24 FPS に戻さない限り、この新しいフレームレート(30 FPS)を既定と
して維持します。

たとえば、30 フレーム/秒の NTSC フレームレートを使用してビデオ用の 90 フ
レームのアニメーションを作成すると、3 秒のアニメーションが完成します。後
で PAL ビデオに(25 フレーム/秒で)出力する必要がある場合は、PAL フレーム
レートに切り替えることができます。90 フレームは 75 フレームに変換され、
フレーム数が異なる同じ合計時間のアニメーションが生成されます。NTSC フ
レームレートに戻して元の 90 フレームのアニメーションを復元することも可能
です。

MotionBuilderの出力のフレームレートをいつでも変更して、正しいフレーム
数を出力し、アニメーションデータを失うことなくアニメーションの再生速度

を正しく維持することができます。

動作環境

このチュートリアルを完成させるには、現在のバージョンの 3ds Max および
MotionBuilderがシステムにインストールされている必要があります。

3ds Max の最新バージョンをお持ちでない場合は、オートデスクの Web サイト
(http://www.autodesk.co.jp/3dsmax)からソフトウェアの体験版をダウンロードで
きます。
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このチュートリアルで使用するアセット:

■ skeletons.max
■ bone_skeleton.FBX
■ bone_skeleton_characterized.FBX
■ biped.FBX
■ Pepe.max
■ Pepe.FBX
■ Pepe_rigged.FBX
■ IceSlip.fbx
■ Pepe_Mocap.FBX
■ Pepe_keyanim.FBX

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

3ds Max のスケルトン

このチュートリアルでは、3ds Max の標準的なボーンシステムのスケルトン
データを FBX フォーマットで書き出し、MotionBuilderに読み込みしてキャラ
クタライズする(アニメートできる状態にする)方法を説明します。

このチュートリアルで使用するアセット:

■ skeletons.max
■ bone_skeleton.FBX
■ bone_skeleton_characterized.FBX

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。
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事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

3ds Max のスケルトンをMotionBuilderで書き出し

およびキャラクタライズする

次の手順では、従来の 3ds Max のボーンシステムのスケルトンを書き出し、3ds
Max の Send To 機能を使用してアニメーションのためにMotionBuilderでそれ
を開きます。

注: このチュートリアルでは、MotionBuilderメニューオプションを使用して、
MotionBuilderおよび 3ds Max 3 のシングルステップの相互運用ワークフ
ローを使用します。レガシーのワークフローについては、MotionBuilderヘル
プのトピック「3ds Max のスケルトンを MotionBuilderに書き出す」を参照し
てください。

スケルトンを FBXフォーマットで書き出するには:

1 3ds Max を起動します。

2 アプリケーションメニューから開く > 開くを選択します。

3 Open File ダイアログボックスで、MotionBuilderのルートディレクトリ
の Tutorialsフォルダに移動し、シーンファイル skeletons.maxを開きま
す。
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注:  File Load: Gamma & LUT Settings Mismatch ダイアログボックスが
表示された場合は、Adopt the File’s Gamma and LUT Settings を選択し
て OK をクリックします。

File Load: Gamma & LUT Settings Mismatch
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注: File Load: Units Mismatch ダイアログボックスが表示された場合は、
Adopt the File's Unit Scale を選択して OK をクリックします。

File Load: Units Mistmatch

skeletons.maxファイルを開くと、2 つのスケルトンが表示されます。ス
ケルトン A は 3ds Max の標準的なボーンシステムで作成されたもので、
スケルトン B は 3ds Max の biped (二足歩行)作成オプションを使用して作
成されたものです。

2つの 3ds Maxスケルトン A. 3ds Maxの標準的なボーンシステムのスケルトン B.
3ds Maxの Bipedスケルトン

これらのスケルトンは「T」スタンスをとっています。アニメータは通常、
このポーズでスキニングを行います。

注: キャラクタをMotionBuilderに書き出する前に、必ずキャラクタをこ
の T 字型のスタンスに配置する必要があります。
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3ds Max の Biped 作成オプションを使用して作成されたスケルトンを書き
出する方法については、3ds Max で Biped を作成して書き出する(141ペー
ジ)を参照してください。

4 スケルトン A 全体をドラッグして領域選択します。

Tスタンスで方向を指定された Biped

ボーンの名前がMotionBuilderの規則に従って設定されており、T スタン
スになっているので、スケルトンは完全にキャラクタライズされます。

MotionBuilderヘルプ > 「キャラクタをアニメートする」 > 「キャラクタ
セットアップ」 > 「スケルトン」 > 「ボーン命名規則」を参照してくださ
い。

5 Application メニューから Send to > Send to MotionBuilder > Send as
New Scene を選択します。MotionBuilderが起動します。

注: 2012 以前のバージョンのMotionBuilderおよび 3ds Max を使用して
いる場合、Send to オプションにはアクセスできません。MotionBuilder
ヘルプを参照してください。

これで、3ds Max のボーンシステムのスケルトンがMotionBuilderにロー
ドされます。
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3ds Maxのスケルトンが Viewerウィンドウに
表示されます。

スケルトンをキャラクタライズするには:

1 MotionBuilderの Asset Browser で Templates > Characters を展開し、
キャラクタアセットをスケルトンのいずれかのボーン上へドラッグしま

す。

アセットをボーンにドラッグすると、ボーンがハイライト表示されます。

2 表示されるメニューで Characterize をクリックします。

キャラクタが T-スタンスをとり、Z 軸の正の方向(3ds Max では Y 軸の負
の方向に相当。.maxファイルを FBX フォーマットで書き出した際に変換
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しました)を向いている必要があることを警告するダイアログボックスが

表示されます。

3 表示される Character ダイアログボックスで Biped をクリックして、キャ
ラクタに適用するリグのタイプを指定します。

Character stanceダイアログボックス

これで、スケルトンがキャラクタライズされました。つまり、アニメート

できるコントロールリグを設定できるようになりました。

4  Character Controls ウィンドウ > Character メニュー
から、Character を選択します。

5 Character Controls ウィンドウ > Source メニューから、Control Rig を選

択します(  > Create > Control rig を選択することもできますが、
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リグをソースとして設定すると、スケルトンはシーン内のアクティブなキャ

ラクタになります)。
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Character Controlsの Sourceメニュー
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後でキャラクタにキーフレームを設定するためには、Control Rig Input
設定を使用する必要があります。

Create Control Rig ダイアログボックスが表示されます。

6 FK/IK をクリックします。

FK と IK は、キャラクタをアニメートするときに一般的に使用される手法
です。

この操作により、コントロールリグがアクティブになり、Character
Controls のキャラクタ表示が有効になります。キャラクタ表示は、Biped
スケルトンを人間の形をしたイメージで表したものです。キャラクタ表示

には、コントロールリグのアニメートに使用できるすべてのエフェクタが

表示されます。

FK/IKコントロールリグが設定されたスケルトン

これでキャラクタのリギングが完了し、アニメートできる状態になりまた。

7 Character Controls ツールバーで、フルボディアイコンをクリックしま
す。
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Character Controls A.フルボディアイコン

これにより、コントロールリグ全体を使用してボディを移動できます。
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8 キャラクタ表示で、右手首のエフェクタを選択します。

キャラクタ表示 A.右手首のエフェクタを選択する

9 Viewer ウィンドウ内でクリックし、Tキーを押します。

座標変換ハンドルが表示されます。

10 次の図のように、手を下へ動かします。
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手を動かすと腕が伸び、それに合わせて体の他の部分も自然に動きます。

これで、キャラクタライズしたスケルトンを変形することができるように

なりました。

注: この手順の結果を確認したい場合は、
bone_skeleton_characterized.FBXファイルを開いてください。

3ds Max の Biped

このチュートリアルでは、3ds Max で Biped システムを使用して Biped スケル
トンを作成し、そのスケルトンをMotionBuilderでアニメートするために書き
出す方法を説明します。

このチュートリアルの結果のアセットは次のとおりです。

■ biped.FBX

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

3ds Max で Biped を作成して書き出する

ここでは、3ds Max で Biped を作成し、MotionBuilder用に書き出する方法を
説明します。
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注: このチュートリアルでは、MotionBuilderメニューオプションを使用して、
MotionBuilderおよび 3ds Max 3 のシングルステップの相互運用ワークフ
ローを使用します。レガシーのワークフローについては、MotionBuilderヘルプ
のトピック「MotionBuilder」を参照してください。

3ds Maxで Bipedを作成し、MotionBuilder用に書き出するには:

1 3ds Max を起動します。

2 アプリケーションメニューから[リセット]を選択してシーンと設定をクリ
アします。

3 Create パネルで Systems を選択します。

[作成]パネルで[システム]が選択された状態

4 Object Type ロールアウトで Biped をクリックします。

5 パースペクティブビューポートをクリックしてドラッグし、Biped オブ
ジェクトを作成します。

注: ここでは Biped のサイズは重要ではありません。
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3ds Maxの Bipedオブジェクト

6 Motion コマンドパネルを開きます。

7 Bip001 を選択したまま、Motion パネル > Biped ロールアウトに移動し、
Figure Mode をクリックします。

[フィギュアモード]が選択された状態

8 Structure ロールアウト > Body Type 領域 > Neck Links スピナーボック
スに 4と入力します。
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首に 10個のリンクを持つ Biped

3ds Max Biped オブジェクトの首に 4 個のリンクが設定されました(次の
図を参照)。

首に 4個のリンクを持つ 3ds Max Bipedオブジェクト

9 [脊椎のリンク]スピナーボックスに 10、[指]スピナーボックスに 5、[指の
リンク]スピナーボックスに 3、[足の指]スピナーボックスに 5、[足の指の
リンク]スピナーボックスに 3と入力します。

10 [モーション]パネル > Biped ロールアウトに移動し、[フィギュアモード]
をもう一度クリックして入力モードを終了します。

11 Application メニューから Send to > Send to MotionBuilder > Send as
New Scene を選択します。MotionBuilderが起動します。

12 MotionBuilderで、Viewer ウィンドウ内にカーソルを置き、[A]キーを押
して Biped スケルトン全体をフレームします。

144 | 第 1 章 チュートリアル



3ds Maxの Bipedスケルトンを MotionBuilderに読み込みした状態

13 Select File To Export ダイアログボックスで、既定のディレクトリ
MotionBuilderTutorials以外で、ファイルの保存に使用するディレクトリ
に移動し、ファイルに My_bipedという名前を設定します。ファイルのタ

イプとして Autodesk (*FBX) を選択し、Save をクリックします。

注:

場所を指定しないと、ファイルは自動的に 3ds Max Export フォルダに
FBX フォーマットで保存されます。

これで、Biped が FBX ファイルとして保存されます。次のチュートリアル(3ds
Max の Biped を MotionBuilder でキャラクタライズする (146ページ))では、こ
の FBX ファイルを使用して Biped をMotionBuilderでキャラクタライズしま
す。

注: この手順の結果を確認したい場合は、biped.FBXファイルを開いてくださ
い。
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3ds Max の Biped をMotionBuilderでキャラクタラ

イズする

以下の手順では、MotionBuilderにより、前の手順(3ds Max で Biped を作成し
て書き出する (141ページ))で保存した 3ds Max Biped (My_biped.FBX)をキャラ
クタライズします。Biped をキャラクタライズすると、Biped のボーンにコント
ロールリグが割り当てられます。ここでのキャラクタライズは、MotionBuilder
が Biped スケルトンをリギングするプロセスで使用する名称でもあります。

注: 前の手順を省略した場合は、システム上のMotionBuilderディレクトリ内
の Tutorialsフォルダにある biped.FBXファイルを使用してください。

3ds Max Bipedをキャラクタライズするには:

1 スケルトンの肩(Upperarm)ノードを選択し、[R]キーを押して Rotation
モードに入ります。スケルトンの腕を、グリッドと並行になるまで回転さ

せます。もう一方の肩も同様にします。

スケルトンの肩を回転させて T-スタンスにする。

スケルトンが T-スタンスになりました。

2 Asset Browser で Templates > Characters を展開し、3ds Max Biped
Template をスケルトンの上にドラッグします。
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Bipedスケルトンに 3ds Max Biped Templateアセットを適用します。

3ds Max Biped Template は、3ds Max で作成された Biped 専用のテンプ
レートです。3ds Max Biped の命名規則はそのままではMotionBuilderで
認識できないため、このテンプレートを使用する必要があります。

3 表示されるメニューで Characterize をクリックします。

これで、Biped スケルトンがキャラクタライズされました。

4  Character Controls ウィンドウで Definition タブを
クリックします。
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キャラクタリプリゼンテーションにより、キャラクタライズが正常であることがわ
かります。
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キャラクタリプリゼンテーションは、キャラクタライズが正常な場合は緑

色、潜在的な問題が検出された場合は黄色、問題のあるスケルトンマッチ

ングの要素が存在する場合は赤色を示します。

次の手順ではコントロールリグを追加して、この Biped スケルトンをアニ
メートできるようにします。

5  Character Controls ウィンドウ > Source メニューか
ら Control Rig を選択します。
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Character Controlsの Sourceメニュー

Create Control Rig ダイアログボックスが表示されます。
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6 Create Control Rig ダイアログボックスで FK/IK をクリックします。

FK と IK は、キャラクタをアニメートするときに一般的に使用される手法
です。

Control Rig をオンにすると、キャラクタリプリゼンテーションが有効に
なり、Viewer ウィンドウの Biped にはコントロールリグエフェクタが表
示されます(B)。

キャラクタリプリゼンテーションは、Biped スケルトンを人間の形をした
イメージで表したものです。キャラクタ表示には、コントロールリグのア

ニメートに使用できるすべてのエフェクタが表示されます。これで Biped
のリギングが完了し、アニメートできる状態になりました。

7 Character Controls ツールバーでフルボディアイコンをクリックします。
これにより、コントロールリグ全体を使用してボディを移動できます。
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Character Controls A.フルボディアイコン

8 キャラクタ表示で、右手首のエフェクタを選択します。
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キャラクタリプリゼンテーション A.右手首のエフェクタを選択した状態

9 Viewer ウィンドウ内でクリックし、Tキーを押します。

座標変換ハンドルが表示されます。

10 次の図のように、手を下へ動かします。

手を動かすと腕が伸び、それに合わせて体の他の部分も自然に動きます。

これで、キャラクタライズした 3ds Max の Biped をMotionBuilderで変
形およびアニメートすることができるようになりました。詳細は、「3ds
Max のキャラクタを MotionBuilder でアニメートする(162ページ)」を参
照してください。
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3ds Max のキャラクタ

このチュートリアルでは、スケルトンが 3ds Max で作成され、スキニングされ
たキャラクタを FBX ファイルフォーマットで書き出し、MotionBuilderに読み
込んでキャラクタライズする(アニメートできる状態にする)方法を説明します。

書き出するキャラクタは、スケルトンにスキンとテクスチャを適用したもので

す。したがって、手順は 3ds Max のスケルトンや Biped スケルトンを書き出す
るチュートリアルと似ています。

このチュートリアルで使用するアセット:

■ Pepe.max

このチュートリアルの結果のアセット:

■ Pepe.FBX
■ Pepe_rigged.FBX

注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

3ds Max のキャラクタを書き出する

次の手順では、3ds Max キャラクタをMotionBuilderに書き出する方法につい
て説明します。
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注: このチュートリアルでは、MotionBuilderメニューオプションを使用して、
MotionBuilderおよび 3ds Max 3 のシングルステップの相互運用ワークフロー
を使用します。レガシーのワークフローについては、MotionBuilderヘルプの
「3ds Maxのキャラクタを書き出す」を参照してください。

3ds Maxのキャラクタ Pepeを書き出するには:

1 3ds Max を起動します。

2 アプリケーションメニューから[リセット]を選択してシーンと設定をクリ
アします。

3 [開く]を選択し、MotionBuilderルートディレクトリ内の Tutorialsフォ
ルダにある Pepe.maxシーンファイルを開きます。
Pepe.maxシーンファイルが開き、メッシュで覆われた Biped スケルトン
が表示されます。
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メッシュで覆われた 3ds Max Bipedスケルトン

4 Application メニューから Send to > Send to MotionBuilder > Send as
New Scene を選択します。

注: 2012 以前のバージョンのMotionBuilder、および 3ds Max を使用し
ている場合Send to オプションにはアクセスできません。MotionBuilder
のドキュメントを参照してください。

5 MotionBuilderが起動し、キャラクタ Pepe が Viewer ウィンドウに表示
されます。

6 Viewer ウィンドウ内にカーソルを置き、[A]キーを押してキャラクタ全体
をフレームします。
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3ds Maxのキャラクタ Pepeを MotionBuilderに読み込みした状態

7 既定のMotionBuilderTutorialsディレクトリ以外のディレクトリに移動
し、ファイルを My_Pepeとして保存します。

3ds Max のキャラクタをMotionBuilderでキャラク

タライズする

以下の手順では、前の手順(3ds Max のキャラクタを書き出する (154ページ))で
保存した My_Pepe.FBXファイルをキャラクタライズします。キャラクタ Pepe
は、3ds Max の Biped にメッシュとマテリアルのみを適用したものです。

注: 前の手順を省略した場合は、システム上のMotionBuilderディレクトリ内
の Tutorialsフォルダにある Pepe.FBXファイルを使用してください。

キャラクタをキャラクタライズするには:

1 Viewer ウィンドウで、Ctrl+Aキーを何度か押して X-Ray モードに切り
替えます。

X-Ray モードでは、キャラクタのスキンの下にあるスケルトンも表示され
ます。

2 Asset Browser で Templates > Characters を展開し、3ds Max Biped
Template アセットをキャラクタ Pepe のスケルトンの上にドラッグしま
す。
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キャラクタPepeのスケルトンに 3ds Max Biped Templateアセットを適用します。

3ds Max Biped Template は、3ds Max で作成された Biped 専用のテンプ
レートです。3ds Max Biped の命名規則はそのままではMotionBuilder側
のキャラクタで認識できないため、このテンプレートを使用する必要があ

ります。

3 表示されるメニューで Characterize をクリックします。

4  Character Controls ウィンドウ > Source メニューか
ら Control Rig を選択します。
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Biped にキーフレームアニメーションを適用するためには、Control Rig
Input 設定を使用する必要があります。

5 Create Control Rig ダイアログボックスで FK/IK をクリックします。

FK/IKをクリックします。

FK と IK は、キャラクタをアニメートするときに一般的に使用される手法
です。

この設定により、コントロールリグがアクティブになり、キャラクタ表示

が有効になります。キャラクタ表示は、キャラクタのスケルトンを人間の

形をしたイメージで表したものです。キャラクタ表示には、コントロール

リグのアニメートに使用できるすべてのエフェクタが表示されます。これ

で Biped のリギングが完了し、アニメートできる状態になりました。

Biped 上にコントロールリグエフェクタが表示されます(次の図を参照)。

6 Character Controls ツールバーで Full Body モード( )が選択されて

いることを確認します。

Full Body モードを有効にすると、ボディパーツだけでなくリグ全体をコ
ントロールできます。

7 キャラクタ表示で、右手首のエフェクタを選択します。
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右手首のエフェクタが選択された状態

8 Viewer ウィンドウ内でクリックし、Tキーを押します。

座標変換ハンドルが表示されます。

9 次の図のように、手を下へ動かします。

手を動かすと腕が伸び、それに合わせて体の他の部分も自然に動きます。

これで、モーションキャプチャやキーフレームアニメーションを使用し

てキャラクタをアニメートできる状態になりました。

10 既定のMotionBuilderTutorialsディレクトリ以外のディレクトリに移動
し、ファイルを My_Pepe_riggedとして保存します。

注: このファイルを使用して、次のチュートリアルを行います(あるいは、システ
ム上のMotionBuilderルートディレクトリ内の Tutorialsフォルダにある
Pepe_rigged.FBXファイルを使用してもかまいません)。
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詳細は、「3ds Max のキャラクタを MotionBuilder でアニメートする(162ペー
ジ)」を参照してください。

3ds Max のキャラクタをMotionBuilderでアニ
メートする

MotionBuilderでキャラクタをアニメートするには 2 通りの方法があります。1
つは手動でキーフレームを設定する方法、もう 1 つはモーションキャプチャ
データを使用する方法です。このチュートリアルでは、3ds Max のキャラクタ
(154ページ)のセクションで読み込みした 3ds Max キャラクタ Pepeをアニメー
トする方法を説明します。

前のセクション(「3ds Max のキャラクタを MotionBuilder に読み込みしてキャ
ラクタライズする (157ページ)」)の手順を省略した場合は、システム上の
MotionBuilderルートディレクトリ内の Tutorialsフォルダにある
Pepe_rigged.FBXファイルを使用してください。

これらのアニメーションチュートリアルの最初の「モーションキャプチャデー

タを使用してキャラクタをアニメートする (163ページ)」では、MotionBuilder
に付属するモーションキャプチャファイルの 1 つを使用して Pepeをアニメー
トします。2 つ目のチュートリアルの「キーフレームを使用してキャラクタア
ニメーションを修正し、3ds Max に書き出する(169ページ)」では、キーフレー
ムを使用してアニメーションを修正し、編集したアニメーションを 3ds Max に
戻します。

注: MotionBuilderでキャラクタをアニメートする方法をご存知の方は、このセ
クションは省略してかまいません。

このチュートリアルで使用するアセット:

■ Pepe_rigged.FBX
■ Iceslip.fbx

このチュートリアルの結果のアセット:

■ Pepe_Mocap.FBX
■ Pepe_keyanim.FBX
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注: チュートリアル用のアセットは Asset Browser の Tutorialsフォルダおよび
システム上のMotionBuilderフォルダ内にあります。

事例: チュートリアルおよびチュートリアル用アセットの最新版を使用するに
は、http://www.autodesk.com/motionbuilder2013-documentationにアクセスし
て、システムにチュートリアルおよびチュートリアルサポートファイルをダウ

ンロードしてください。MotionBuilderの既定の場所以外へチュートリアルサ
ポートファイルをダウンロードした場合、Asset Browser 経由でアセットにアク
セスできるように、この場所を Asset Browser に追加してください。ヘルプの
「MotionBuilder インタフェース」の Asset Browserのトピック、「よく使用
するパスを追加する」を参照してください。

まだMotionBuilderを使い慣れていない方は、まずMotionBuilderのキーボー
ドショートカットを使用したMotionBuilderの操作を練習しましょう。

■ Ctrl+Shiftキーを押しながらドラッグしてシーンをオービットする

■ Ctrlキーを押しながらドラッグしてシーンをズームイン/アウトする

■ Shiftキーを押しながらドラッグしてシーンをパンする

このチュートリアルの手順ではMotionBuilderのキーボードショートカットを
使用していますが、3ds Max のキーボードショートカットを使用することもで
きます。

MotionBuilderヘルプの「キーボードショートカット」の「3ds Max キーボー
ドショートカット」に、3ds Max のすべてのキーボードショートカットの一覧
があります。

モーションキャプチャデータを使用してキャラク

タをアニメートする

次の手順では、MotionBuilderキーフレームアニメーションのテクニックを用
いてモーションキャプチャアニメーションを微調整する方法を学びます。

セクション「3ds Max のキャラクタを MotionBuilder でキャラクタライズする
(157ページ)」の前述の手順を省略した場合は、システムのTutorialsフォルダに
あるMotionBuilderルートディレクトリの Pepe_rigged.FBXファイル、また
は Asset Browser の TutorialsフォルダにあるMotionBuilderの Pepe_rigged
アセットを使用できます。
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モーションキャプチャデータを使用してキャラクタ Pepeをアニメートするに
は:

1 MotionBuilderを起動します。

2 Asset Browser の Tutorialsフォルダから、セクション「3ds Max のキャ
ラクタを MotionBuilder でキャラクタライズする (157ページ)」の前述の
手順で保存したMy_Pepe_riggedアセット(My_Pepe_rigged.FBXファイ
ル)を Viewer ウィンドウにドラッグします。

注: 前のセクション(3ds Max のキャラクタを MotionBuilder でキャラク
タライズする(157ページ))の手順を省略した場合は、Pepe_riggedアセッ
ト(Pepe_rigged.fbxファイル)を Viewer ウィンドウへドラッグしてくださ
い。

注: 元の .fbxファイルを上書きしないように、必ず既定の
MotionBuilderTutorialsディレクトリ以外のディレクトリに移動してから、
ファイルを保存してください。

3 FBX Open > No Animation を選択します。

キャラクタ Pepe が Viewer ウィンドウに表示されます。

ファイルのロード A. Asset Browserの Pepe_riggedアセット B.シーンに Pepe
がロードされる

4 Viewer ウィンドウの空の領域をクリックし、Aキーを押して全体をフレー
ムし、キャラクタ Pepeにズームインします。

5 Ctrl+Aキーを何度か押して X-Ray モードに切り替えると、Pepe のスケ
ルトンとコントロールリグが表示されます。
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X-Rayモードで表示した Pepeのコントロールリグ

6 Ctrl+Shiftキーを押しながらドラッグしてシーンをオービットし、キャ
ラクタ Pepeの右側面を表示します。次の図を参考にしてください。

Pepeをオービットします。

7 Asset Browser > Tutorialsフォルダで IceSlipアセット(IceSlip.fbxファイ
ル)を選択し、Viewer ウィンドウの空の領域にドラッグします。

8 FBX Merge > IceSlip を選択します。

Pepeのシーンにモーションキャプチャデータ(大きな黄色いスケルトン)
がマージされます。

9 黄色いスケルトンが表示されるまで、シーンをズームアウト(Ctrlキーを

押しながら左下へドラッグ)します。
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Pepeと、モーションキャプチャデータを持つスケルトン

10 Transport Controls の右側にあるドロップダウンメニュー(B)から 30 fps
を選択します。

11 Transport Controls の Play ボタン(A)をクリックして、黄色いスケルトン
の IceSlipのアニメーションを再生します。

Transport Controls A. Playボタン B. 30 fpsが選択されている

12  Character Controls で、キャラクタリストに PEPE
と表示されていることを確認します。Character Controls ウィンドウ >
Source メニューから Skeleton2 を選択します(Skeleton2 は、モーション
キャプチャアニメーションを持つ黄色いスケルトンの名前です)。
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Pepeはスケルトンの姿勢になります(次の図を参照)。
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13 Transport Controls のタイムラインインジケータをドラッグしてアニメー
ションをスクラブします。あるいは、Jキーを押しながら Viewer ウィン
ドウ内を左右にドラッグする方法もあります。

これで、スケルトンのアニメーションがキャラクタ Pepeを駆動するよう
になりました。

14 Pepe だけが表示されるようになるまでCtrl+Aキーを何度か押し、フレー
ム 92 に移動して Pepeにズームインします。

15 Ctrl+Shiftキーを押しながらドラッグして Pepeをオービットします。
注意して見ると、Pepe の片方の手が顔を貫通してしまっていることが分か
ります。

モーションキャプチャが原因で、手の動きに問題が生じている状態

16 問題の動きを確認できるまで、アニメーションを何度かスクラブしてみて

ください。
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Pepe のボーンの動きをコントロールするアニメーションが、生理学的に
まったく異なるスケルトンをベースにしているためです。たとえば、Pepe
の頭や手足は黄色いスケルトンと比べるとかなり大きく、肩ははるかに小

さいことが分かります。

17 ファイルを My_Pepe_Mocap.fbxという名前で保存します。
次のチュートリアルでは、このファイルにキーフレームを追加して、Pepe
の手の動きを修正します。

また、次のチュートリアルでは、修正したキャラクタを 3ds Max へ再度書
き出する方法も紹介します。

キーフレームを使用してキャラクタアニメーション

を修正し、3ds Max に書き出する

MotionBuilderでは、キャラクタに手動でキーフレームを設定することでキャ
ラクタをアニメートできます。この方法は、オリジナルのアニメーションを作成

する場合や、モーションキャプチャアニメーションに修正を加えたい場合に役

立ちます。

次の手順では、キーフレームアニメーションを使用してモーションキャプチャ

アニメーションを微調整し、編集したアニメーションとキャラクタを書き出して

3ds Max に戻します。

MotionBuilderでキャラクタにキーフレームを設定する方法をご存知の方は、
手順 21 に進み、3ds Max にキャラクタを書き出しできます。

注: このチュートリアルでは、MotionBuilderメニューオプションを使用して、
MotionBuilderおよび 3ds Max 3 のシングルステップの相互運用ワークフ
ローを使用します。これらの製品の 2012 バージョンまたは 2013 バージョンが
ない場合は、MotionBuilderヘルプを参照してください。

キーフレームを使用してモーションキャプチャアニメーションを微調整するに

は:

1 MotionBuilderで、前の手順(モーションキャプチャデータを使用してキャ
ラクタをアニメートする (163ページ))で Pepeにモーションキャプチャ
データを適用した結果のファイル My_Pepe_Mocap.fbxを開きます。
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注: 前の手順を省略した場合は、Pepe_Mocap.fbxファイルを開いてくだ
さい。

注: 元の .fbxファイルを上書きしないように、必ず既定の
MotionBuilderTutorialsディレクトリ以外のディレクトリに移動してから、
ファイルを保存してください。

Pepe だけが表示されるようになるまで、[Ctrl]+[A]キーを押します。

2 Character Controls のキャラクタ表示で、右手首のエフェクタをクリック
します。

右手首のエフェクタが選択された状態

3 Viewer ウィンドウ内でクリックし、Tキーを押します。

座標変換ハンドルは表示されません。

4 Pepe の手を動かしてみてください。

手は動かないはずです。それは、Pepe のアニメーションは、コントロール
リグではなくスケルトンによってコントロールされているためです。Pepe
のモーションキャプチャアニメーションにキーフレームを設定するには、

まずスケルトンのアニメーションを Pepe のコントロールリグ上にプロッ
ト(ベイク処理)する必要があります。

5  Character Controls メニューボタンからBake (Plot)
> Bake (plot) To Control Rig を選択します。
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Bake (plot) to Control Rig コマンドでは、アニメーショントラックのベー
スレイヤ(またはBaseAnimationレイヤ)で各フレームごとに 1 つずつキー
が作成されるため、編集しにくくなります。(Pepeの手首のエフェクタを
選択している場合は、作成されたキーフレームが Transport Controls に表
示されます)。

これで、キャラクタ Pepeをコントロールリグを使って編集できるように
なりました。

6 Key Controls で Layer メニューをクリックし、AnimLayer1 を選択しま
す。

キーフレームを追加するために AnimLayer1を選択します。

アニメーションレイヤを選択すると、オリジナルのアニメーションを

BaseAnimation レイヤに保持したまま、アニメーションを編集できます。
AnimaLayer1 を選択すると、BaseAnimation レイヤに設定されているキー
フレームが非表示になり、AnimLayer1 レイヤに設定されているキーフレー
ムが表示されます(現時点では何も設定されていません)。

7 フレーム 80 (問題のある右手の動きが始まるタイミング)に移動します。
Character Controls ウィンドウのキャラクタ表示で右手首のエフェクタを
クリックした後、Key Controls で Key をクリックします。

注: Kキーを押してキーフレームを設定することもできます。

8 フレーム 105 (問題の手の動きが終わるタイミング)に移動して、もう 1 つ
キーを設定します。

以降の手順を実行しても、最初のキーより前および 2 番目のキーの後は、
キャラクタの動きは何も変化しません。フレーム 80 からフレーム 105 ま
での動きだけを修正します。
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9 フレーム 94 (設定した 2 つのキーフレームの中間)に移動します。

10 Viewer ウィンドウで[T]キーを押し、Pepe の手を X 軸と Z 軸に沿って移
動して顔から遠ざけてから(次の図を参照)、キーを設定します。

Pepeの手を顔から遠ざけます。

11 Jキーを押しながら前後にドラッグして、キーを作成したことでキャラク

タの手がどのように反応するかを確認します。

12 必要に応じて、手の動きにさらに修正を加えます。調整するたびにキーを

作成するのを忘れないでください。

13 アニメーションの最後のフレームに移動し、Pepe の体の右側が表示される
ようにビューを調整します。

キャラクタの右手が頭に近すぎます。

14 Pepe の手を体から離して、キーを設定します。
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15 Rキーを押して、キー回転リングを使って手の位置を修正します。手が地

面と変更になったら、さらにキーを設定します。

注: 必要に応じてビューを調整して、Pepe の手が地面の高さと平行になっ
ているかどうか確認してください。

回転リングを使って右手の位置を調整します。

16 アニメーションを再生して結果を確認します。

17 さらにキャラクタの体の位置を調整してから、ファイルを

My_Pepe_keyanim.fbxという名前で保存します。

注: この状態でファイルを保存すると、シーンにはキャラクタ Pepe のアニ
メーションと一緒に黄色いリファレンススケルトンも保存されます。必要

であればシーンからスケルトンを削除したり、キャラクタ Pepe だけを選
択して別のファイルに保存し、そのファイルを 3ds Max に読み込ませるこ
とも可能です。

18 キャラクタ Pepe をドラッグして選択します。こうすることで、3ds Max
に書き出する際に黄色いスケルトンを除外することができます。

19 MotionBuilderメインメニューからFile > Send To 3ds Max > Send as
New Scene を選択します。
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File > Send to 3ds Max > Send as New Scene

3ds Max が起動し、アニメートされたキャラクタ Pepe がビューポートに
ロードされます。

20 編集したMotionBuilderアニメーションを表示するには、3ds Max
Animation Controls で Play をクリックします。

3ds Maxで再生される Pepeのアニメーション

まとめ

この一連のチュートリアルでは、3ds Max で作成された数種類のスケルトンを
扱い、MotionBuilderに書き出しました。MotionBuilderでは、ボーンをキャ
ラクタライズし、キャラクタをアニメートしました。

次に、モーションを仕上げるためのいくつかの調整を行い、キャラクタ Pepe を
書き出して 3ds Max に戻しました。
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